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1.1 Content Manager Overview 

Scala Content Manager is a breakthrough in media broadcast 

distribution, scheduling and management technology. The 

product set allows the user to create content (Designer), manage 

the content (Content Manager) and publish or play the content 

(Player). 

 

Additionally, using Content Manager your networks and players 

can be fully managed and monitored, thereby easily keeping your 

players up and running.  

This user guide has been coupled with the Quick Start Guide.   
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It will be important for users to read through the quick start guide 

BEFORE you install the software. This will make sure you have a 

thorough understanding of the options which can be selected, 

and the settings and configurations you can choose as you install 

Content Manager.  

1.2 Player Installation and Configuration   

 

This section provides three different types of physical Player 

configurations to Content Manager. 

 Content Manager Direct – The plan file is retrieved from 

the Content Manager’s web folder. This is the most 

common combination of networks and players currently 

used by most customers 

 Player-Direct FTP – The plan file is retrieved from the 

player’s built in FTP server. 

 Push to Player – The plan file is retrieved from a shared 

folder. This shared folder can reside directly on the player, 

or be located on a shared server from which the Content 

Manager and the Player have access. 

The most basic network configuration is: 

 Scala Content Manager is configured to store the player 

plans in the web folder (Content Manager Direct option). 

 

 Scala Player(s) retrieves its plans using the “Content 

Manager Direct” option.  
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 Scala Designer publishes directly to Scala Content 

Manager using the “Content Manager Direct” option. 

 

In this above example, Scala Designer, Scala Content Manager, 

and Scala Player are on separate computers:  

 

Within these basic configurations, you can use different 

configuration options: 

For example: Instead of publishing from Designer directly to  

Scala Content Manager, you can publish to a shared folder or 

FTP site (from which both Designer and Content Manager have 

access). You could then setup a Publish location in Content 

Manager which would reference that location.  

Content Manager would then poll the location for changes based 

on the interval which has been configured. Instead of Players 

retrieving the plan file directly from Content Manager, Content 

Manager could deliver the plan file directly to the player (using 

the Player Direct FTP option).  

To do this, in Content Manager change the delivery type to 

Player-Direct FTP, and enter a password. Then on the player, 

change the delivery type to Player-Direct FTP and enter the 

same password you used in Content Manager. Note: The FTP 

password must match in both configurations.  
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1.3 Licensing  

All Scala Players receive their license directly from Scala Content 

Manager5. Players must be able to contact Scala Content 

Manager every so often to obtain an updated license. Without a 

valid license, your content will not play back. 

1.4 Hardware Requirements 

 

Carefully follow the recommendation for all hardware 

requirements to insure the maximum performance of you Content 

Manager system. 
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1.5 Installation 

 

Installing Scala Content Manager is a relatively simply process 

when followed closely.  The install wizard will allow the user to 

quickly install the product.  
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Insert the Content Manager disk into your computer.  The 

installer should run automatically. 

The Content Manager DVD now opens a setup-chooser letting 

you easily pick which of the products or extensions you wish to 

install.  

However if the installer does not start, Select on Start /Control 

Panel/Add or Remove Programs. 
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The list will either be by detailed view or by icon view.  Select Add 

or Remove Programs. 

The dialog box will instruct the user to select either: Add a 

program from CD-ROM or Add programs from Microsoft. 
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Select the button that says CD or Floppy. 

Your Content Manager software also comes with a USB key that 

you must insert into a USB slot on your computer in order to use 

Scala Content Manager. 

The dialog box will appear allowing you to begin the installation 

from the DVD.  Select Next. 
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Another option is to right click on Start and select Explore. 

 

Identify the drive for the DVD. Select it from the menu options.  

The list of items on the DVD includes everything you will need to 

install Content Manager. 
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Select the setup.exe by double clicking on the icon. 

 

The first option you will have is to view this Quick Start Guide as 

a .pdf. 

 

Once you are ready to install select Next. 

  on 
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1.6 Microsystems Sun Java Runtime 

 

If you do not have a version of Microsystems Sun Java Runtime 

installed on your computer, the Content Manager installer will 

require that you install this now.   

 

Select Yes to continue.  The Content Manager software will 

recommend the version of Runtime to install. 

 

Select Yes to continue. 

The installer will install Sun Java Runtime.  The installer dialog 

box will provide information about the progress of the install. 

Note:  The Java Runtime Environment (JRE), also known as 

Java Runtime is part of the set of programming tools for 

developing Java applications. 

1.7 DirectX 9.0 

 

Scala Content Manager requires that the user have Microsoft 

DirectX 9.0c (with Software Rasterizer).     
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If the installer cannot identify that your machine has this program 

installed, a dialog box will ask that you install it. 

Select Yes to continue. 

 

The installer dialog box will provide information about the 

progress of the install. 

Once DirectX 9.0c installs the dialog box will close automatically. 

1.8 Apache Tomcat Server 

 

Scala Content Manager requires that the user have Apache 

Tomcat web application server.  

If the installer cannot identify that your machine has this program, 

a dialog box will ask that you install it. 
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Select Yes to continue.   

   

Note: Apache Tomcat implements the Java Servlet and the Java 

Server Pages (JSP) specifications from Sun Microsystems, and 

provides a "pure Java" HTTP web server environment for Java 

code to run. 

 

The installer dialog box will provide information about the 

progress of the install. 
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When the Welcome to Scala Content Manager  Setup Wizard 

dialog box opens, you must select the “I accept the agreement” 

button in the Scala End User License Agreement box.  

The full EULA can be read here or is also available at the end of 

this document.   

Select the language for Content Manager.  The list of the 

available languages appears in the dialog box.  Choose the 

appropriate radio button and then select Next. 
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The destination location dialog box will default to the typical 

C:\Program Files location. 

 

You can choose a different location by choosing the browse 

button in the dialog box.   

 

Select the appropriate Data Location.  This will default to store 

media items in a specific location.  
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If the default location is acceptable, select Next to continue. 

Choose the appropriate radio button for the Database Installation 

option. 

 

Select Next to continue. 

The PostqreSQL Database Service defaults to the Service that 

occurs as part of the database installation process. 
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You must choose an account password, verify the account 

password and Select Next to continue. 

You must choose a password that is a minimum of eight 

characters. 

 

Because there are different passwords needed for parts of the 

installation, be sure to record your passwords in a secure place 

where they can be accessed at a later time. 

 

Since this account does not exist, select Yes to create the 

account. 
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Next you must select a password for the database account 

configuration.  There are no limits on the length of the password.    

 

Select a strong password and again record your passwords in a 

secure place where they can be accessed at a later time.  

You can also change the Superuser name.  The Superuser name 

should also be recorded in a secure place where it can be 

accessed at a later time. 

 

Select Next to continue. 
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The installer will use PostgreSQL default location. Select Next to 

continue or specify a custom folder and then continue.  

 

You can identify the parameters for Content Manager’s web 

application including the virtual folder, port and connection host 

address. 

Select Next to continue. 
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If you choose use localhost as your Connection Host Address, 

then only a Scala Player installed on the computer on which you 

are installing Content Manager will be able to communicate with 

Content Manger. 

A dialog box will appear to warn you of this option. 

Correct the target Connection Host Address or Select Next to 

continue. 

 

The web address must be the exact URL that is reachable by 

your player.    

    

Select Yes to continue. 
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The installer will specify the virtual folder and port where Content 

Manager web application will be installed. 

 

Select Next to continue. 

The installation will choose a data location.    

 

If this is the accurate location, select Yes or change the location 

using the Browse button and then Select Yes to continue. 
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Select any additional tasks that should be performed.  The 

system defaults to select both services automatically.   

Select Next to continue. 

The setup will identify the connection firewall using Microsoft 

Internet Connection Firewall. 
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Select Next to Continue to allow network connections for Content 

Manager. 

 

Select Next to continue to allow network connections for Apache 

Tomcat.    
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You are now ready to install. Select Install to continue. 

 

At this point, the system is ready to copy files for the PostgreSQL 

database. The installer dialog box will provide information about 

the progress of the install. 
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Content Manager will automatically begin extracting files.  The 

installer dialog box will provide information about the progress of 

the install. 

 

And automatically install any third party components.  Content 

Manager will be installed on your system.  The file extraction can 

be monitored with the progress bar. 
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Once the install is complete, an information dialog box will note 

that the setup must be completed by the software Administrator. 

 

Select Finish, which completes the installation. 

If you select View the Release Notes you can view and read 

them during the installation process. 

You can now proceed with the set up Wizard.  Select Next to 

continue.  
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Enter the Administrator password. Select Next to continue. 

    

Select the “Type” of database configuration.  The typical install 

uses PostgreSQL.   

 

Choose that from the drop down, enter your database password 

and select Next to continue. 

(You can Test the connection by selecting Test.) 
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The Database Monitor will show your successful connections. 

The database monitor will establish the connection and create 

the database schema.  Once created, Select the Next button. 
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Enter the Username (Administrator) and password (previously 

chosen) and select Login. 

.  

Select a name for your Network.  Enter it and choose Create. 

The primary screen for the Scala Content Manager is now 

available to use.  This screen is the place where the user can 

access the entire application and its various components. 
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The User Guide and the Quick Start Guide are available for 

download from these links. 

 

1.9 Logging On To Content Manager 

 

To access Content Manager, find the Scala Content Manager 

program in the list of Programs and select Scala Content 

Manager.  

 

Start/Programs/Scala Content Manager.  This will allow you to 

logon to Content Manager. 

1.10 Getting Started 

 

All users will need to enter their Username and Password in 

order to access the information in Content Manager. 
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Note: Since much of the content in Content Manager is user 

driven and user specific and since Content Manager uses 

workflow for assignments and approvals, it is important that 

all users have separate Usernames.  It is also important that 

Passwords are set according to the security policies of your 

company in order to keep content secure. 

Enter the Administrator username and password and select the 

Login button. 

 

The Content Manager dashboard provides a full array of 

operations for every type of user. 
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The primary screen provides messaging and workflow activities. 

Users will be able to access approvals and messages and review 

rejected messages for re-editing. 
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Menus –  

Expandable 

menus link to all 

of the program 

functions.

Primary Screen –  

Provides 

information about 

messages the 

require attention or 

approval.

Network Status –  

Plan generation and 

version of Content 

Manager.

Network Summary –  

Useful facts about 

the network.

User Manual –  Link to 

download pdf version 

of the manual.

Scala Advantage Reminder 

provides information regarding 

your subscription.

 Copyright 1993 – 2009, Scala, Inc. 

 

Prior to adding users, it is important for users to understand the 

“roles” that they will be assigned to and how to modify roles using 

the roles tool in Content Manager. 
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||||| 2   | System    

Requirements 

and 

Installation 
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2.1 Installing & Configuring Scala Players  

The Scala Player is more than just a computer with a display – it 

is a sophisticated software system.  

The Player not only receives information, it also communicates 

with Content Manager. Additionally, it will automatically report 

back to Content Manager at regular intervals, with a series of 

“heartbeats”, to let it know it is still functioning properly.  

Furthermore, it will check for media updates in scheduled 

playlists with newly-generated plans from Content Manager.  

 

To ensure your sophisticated software continues to run efficiently, 

it is important to start with the right hardware – optimized and 

configured expressly for your broadcast display requirements.  

This section not only addresses the hardware requirements you 

will need to run the Scala Player, but also the configurations 

you’ll need to communicate and transfer your media and 

playlists.   
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The basic hardware requirements for running the Player software 

will vary depending on the installation site and the display 

scenarios involved.  

Your particular set-up will undoubtedly be unique to your needs, 

but the core of the installation is the computer onto which the 

software is going to be installed. Below are some general 

hardware system recommendations: 

2.2  Detailed Hardware Requirements  

 

To ensure the optimum performance from your configuration, 

please carefully review the checklist below to make sure your 

system meets the minimum requirements. 

Failure to properly follow the installation and configuration 

instructions may cause problems with your computer or player 

configurations. 

Note: "#GB/hour of content" means total aggregate traffic.  

1000 Players each downloading a 2MB file equals 

2000MB/hour of traffic and so 10GB/hour for 2000 Players 

means each player is getting a maximum of 50MB of files. 

2.2.1 Recommended Storage 

 

It is generally assumed that a complete Microsoft Server OS 

installation with support utilities consumes approximately 

between 5-15 GB of disk space--including a fixed size paging file 

of between 2 and 4 GB in size. 
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Operational Media Repository Storage.  It is generally 

recommended that hard disk space be allocated to be 3x that 

anticipated media storage need.  (If the total size of the media for 

active scripts for a network of Players is in the order of 10GB--

then at least 30GB of storage should be allocated to this 

requirement). 

Database storage:  The Content Manager 5 database for <1000 

Players with moderate scheduling should be on the order of 

200MB.  If there are many, media types, triggers, etc. the 

database might grow to be on the order of 500MB per 1000 

Players in size.  It is generally suggested that container files for 

the database be located on a partition other than that of the OS 

or the Media Repository. 

For a very high capacity Content Manager--there is substantial 

performance benefit in isolating differing I/O activities by having 

multiple storage volumes. 

An example division of I/O for a very high-capacity Server: 

Volume_1_BOOT_OS_Apps: A 32 to 80 GB RAID-1 2xHD 

storage pack or SSD. 

Volume_2_TEMP_SWAP_Transact: A 36 to 80 GB 2xHD RAID-1 

or 4xHD RAID-1+0 storage pack for the system paging file, 

system %TEMP%/%SPOOL% directories ,and the Transaction 

Logs for the Database. 

Volume_3_DATABASE: A 32 to 160GB SSD or 2xHD RAID-1 or 

4xHD RAID-1+0 or 4xHD RAID-6 storage pack. 
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Volume_4_MEDIA_TRANSMISSION: 144GB to several TB.  

Minimally 4xHD RAID-1+0 or RAID-6.  For volumes of "several 

TB" in size the suggested configuration would be to employ at 

least eight drives in a RAID-6+0 configuration--2x(4xHD RAID-6) 

RAID-0 striped.  As many as possible smaller HD's are preferable 

to "large" devices.  (Based on the known behavior of current HD 

devices, Q3'2008, no HD used should be larger than 750GB). 

File System Fragmentation:  To maintain operational efficiency of 

the storage sub-systems it is strongly encouraged that the 

Content Manager 5 Server be configured with a good 

automatic/background commercial Defragmentation product.  

Both the Diskeeper Corp. "Diskeeper" and RAXCO "Perfect Disk" 

products are recommended.  If SSD's are to be used, please see 

the SSD vendor notes on the appropriateness of defragmentation 

products.  Some SSD devices do benefit from such products if 

the products have been written for the special needs of such 

devices.  Others can be damaged by such software. 

Storage Capacity Sizing and Configuration by Content Manager-

network load class: 

SMALL NETWORKS: A single 40GB or larger, but less than 

750GB, HDD.  RAID-1 encouraged. 

MEDIUM NETWORKS: Two 60GB or larger, but less than 

750GB, HDD's in a RAID-1 configuration.  Appropriate 

partitioning to isolate file system use: 

OS+Apps, Temp_Swap, Database, Media; is encouraged. 
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LARGE NETWORKS: Four HDD's of 36GB or larger size in a 

RAID-1+0 or RAID-6 configuration.  OS+Apps, Temp_Swap, 

Database, Media; is encouraged. 

ENTERPRISE NETWORKS: Two HDD's of 36GB or larger, but 

less than 80GB, size as a RAID-1 boot volume.  Four HDD's or 

36GB or larger size, but less than 750GB, in a RAID-1+0 or 

RAID-6 configuration for data.  The data volume should be 

partitioned with separate file systems for data, swap, transaction 

logs, and media.  Consideration of SSD's for database and 

database transaction logs is not inappropriate. 

2.2.2 Recommended Operating Systems 

 

 Windows XP Professional SP 3 for Small Networks. 

 Windows Server 2003 SP2 Web Edition for Medium and 

Large Networks. 

 Windows Server 2003 SP2 32-bit Standard or Enterprise 

Edition for Enterprise Class Networks. 

NOTE:  Either Microsoft Server OS Client Access 

Licenses, CAL's, or the unlimited "Internet Connector 

Licenses" are required. 

The following operating systems are not approved for 

Content Manager 5: 

 Microsoft 64-bit Operating Systems (Any edition) 

 Microsoft Windows Server 2008 
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 Microsoft Vista (Any edition) 

For purchases of Vista Business Edition, Ultimate Edition, or 

Windows Server 2008 Editions, we suggest the exercise of 

"Downgrade Rights" to a supported Operating system. 

2.2.3 Recommended Processors 

 

SMALL NETWORKS:  Intel Pentium Dual-Core 2180 or better.  

Core2 Duo E6300 or better suggested.  AMD AM2 Athlon-X2 

BE4350 or faster. 

MEDIUM NETWORKS:  Intel Pentium Dual-Core 2180 or better.  

Core2 Duo E6300 or better suggested.  AMD AM2 Athlon-X2 

BE4350 or faster. 

LARGE NETWORKS:  Intel Core2 Duo E6400 or better 

suggested.  AMD AM2 Athlon-X2 5000+, Phenom, or Opteron. 

ENTERPRISE NETWORKS:  Intel Core2 Quad Q6600, XEON 

E5405, or better suggested.  AMD Quad-Core Phenom or 

Opteron. 

2.2.4 Recommended System Memory 

 

SMALL NETWORKS:  Dual-bank, DDR2-5300 or better, 2 GB 

total. 

MEDIUM NETWORKS:  Dual-bank, DDR2-5300 or better, 2 GB 

total. 
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LARGE NETWORKS:  Dual-bank, DDR2-5300 or better, 2 GB 

total.  [4 GB (2.8 to 3.25GB available) with Standard or Enterprise 

Windows Server 2003, 32-bit, in PAE mode] 

ENTERPRISE NETWORKS:  Dual-bank/Triple-bank/Quad-

bank/Hex-bank, DDR2-5300 or better, 2 GB total.  [4 GB (2.8 to 

3.25GB available) with Standard or Enterprise Windows Server 

2003, 32-bit, in PAE mode] 
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3.1 Scala Products 

 

Scala Designer is an authoring application that allows a creative 

resource to quickly create content in the Scala native format, 

called Scala scripts. These scripts are either self-contained 

productions, or templates that can be filled in later. The 

ScalaScript language has very advanced capabilities to build 

content that can behave dynamically, access external data or talk 

to other devices. 

Scala Content Manager5 is a web based application that 

centrally controls all media that will flow through the network. It 

has a media library from which users can create playlists, then 

schedule them to play at specific times and locations.  Scala 

Content Manager also collects data from locations to generate 

reports about player health and playback logs. 

Scala Player software typically runs on a dedicated PC, 

connected to a display device at a remote site. It receives its 

directions from Scala Content Manager, then downloads the 

necessary media files and plays them according to defined 

schedule. 

Scala Ad Manager is a product for larger networks that are 

advertising based.  Scala Ad Manager provides a tool to manage 

advertising programs and networks across multiple channels. 
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3.2 Corporate Messaging 

 

A common use of Scala is to enable corporations to 

communicate more effectively with their employees and 

customers.  Scala lets different stakeholders in an organization 

communicate their messages without requiring email or time-

consuming meetings.   

For example, a screen might be placed in the break room, 

cafeteria or office area with key announcements and messages. 

Many companies also use Scala in the front lobby to welcome 

visitors or VIPs. 

 

In a corporate environment, a graphic designer in the  
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Marketing department can upload videos and create templates 

in Scala Designer.  

Other staff members can use those templates to create their own 

messages with Scala Content Manager’s Template Composer 

Module. Supervisors can approve messages before they are 

displayed.  

Workgroups allow content to be segmented by department. 

Typically a corporate IT group administers the overall network. 

 

3.3 Retail Advertising 

 

The key to effective digital signage in retail is being able to target 

your message with accuracy, make it relevant to the customer, 

and display it at the right time and location where it can affect 

purchase decisions the most.   
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Digital signage in a store can also be used off-hours for staff 

training and corporate messaging. 

Advertising media is created by agencies or marketing 

departments, but location and distribution of that media is usually 

planned by other groups or departments that handle 

merchandising and promotion.  

Scala Content Manager can be configured to allow creative users 

to publish or upload media to Content Manager without being 

involved in the playlist decision. This can be accomplished by the 

in-store promotions group who controls playlist order as well as 

schedules.  

Different channels can be created for different areas of the store, 

and playlists within those channels can be scheduled to appear 

at different times of day, based on customer traffic and store 

hours. 

In networks where each location has unique criteria such as type 

of weather, local branding or services, metadata can be used to 

place alternative entries in a single playlist instead of having to 

make a different playlist for every location.  
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3.4 Public Information 

 

Information for the general public can be distributed via TV 

channels or digital signage to communities, hotel guests, 

students on campus or in a variety of other important settings.  

These networks typically don’t have the same resources as 

corporate or advertising installations, so the ability to keep 

content updated easily and efficiently is key. 
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3.5  User Access and Control 

 

Scala Content Manager 5 has a simple web interface for editing 

template-based messages, and fine control of user access to 

different parts of the interface as well as different content. Users 

can be given control over just the things they need to control.  

Also, with Scala’s Windows Scripting, any data that already 

exists in some other form such as schedules, news feeds or 

localized information does not need to be entered twice. It can be 

imported directly from the source into a script. 
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3.6 Scala Workflow 

 

Scala is designed to enable individuals to work in different roles 

based on their expertise and need for access. These standard 

roles match the default roles installed with Scala Content 

Manager.  

 Graphic Designers typically use Scala Designer to 

create scripts and templates. They might also use Scala 

Content Manager to upload images or videos. 

 

 Message Editors use Scala Content Manager to create 

and edit messages with templates created in Scala 

Designer by the Graphic Artist. 

 

 The Message Approver reviews and approves or rejects 

messages by Message Editors. 

 

 The Schedule Manager sets up playlists of media and 

messages, and schedules when the playlists will appear. 

 

 The Network Administrator configures Scala Content 

Manager’s network settings, and monitors the players for 

errors. 
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Content Manager5 Workflow

 

3.7 Troubleshooting Tips 

 

If your Player is not receiving new plans or is not playing what it 

should be playing, below are some settings you can check: 

1. Check in Content Manager -> Settings -> License Status to 

see if the License file has been downloaded and is current. 

 

2. Check to see if the Content Manager and Player are using 

the current release. In Content Manager, navigate to Settings 

-> Server Settings and select the System Information tab. In 

the Player 5 Configuration, select the Info tab. 
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3. In Content Manager, go to Network -> Players and select a 

Player and click Synchronize Now.  In Content Manager 

check Network -> Network Monitor for the Player “New Plan 

revision downloaded” message. This may take a minute or 

two to for the message to show.  If not go to Step 4. If yes 

then go to Step 9. 

 

4. On the Player system, check to see if the Player 

Transmission Client is running. 

 

5. In the Player 5 Configuration tool, check to see if you are able 

to connect to Content Manager, by clicking the “Refresh” 

button. If so, the Player should load the Network name.  If not 

go to Step 7. 

 

6. Using a web browser on the player, see if you can connect to: 

 

http://[HostNameOrIP:PortNumber] 

 

to see if you can view the Apache Tomcat default web page. 

If the default web page is not shown, check to see if the 

Apache Tomcat Service is running. Also, check if any 

firewalls, routers, and anti-virus software are blocking the web 

port.  

 

7. Open a command prompt on the Player, and type: 

 

PING HostNameOrIP 

 

Where HostNameOrIP is the Content Manager's Hostname or 

IP Address. This is a test to see if the player can talk to the 
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hostname or IP Address of Content Manager. If not, check 

the network connection and cabling. 

 

8. Open a command prompt on the Player, and type: 

 

TELNET HostNameOrIP:portnumber 

 

Where HostNameOrIP is the Content Manager's Hostname or 

IP Address and portnumber is the web port.  This is another 

connectivity test. 

 

9. Check the Incoming Messages folder on the Content 

Manager system.  In Windows Explorer, go to: 

 

C:\Documents and Settings\All Users\Application Data\Scala\ 

InfoChannel Transmission Server 5\Network\Incoming 

Messages. 

 

If there are .XML files in that directory, then the Scala 

Transmission Server is not processing them. This can be 

because Content Manager does not have a valid license or 

the Scala Transmission Server Service not running. 

 

10. Check to see if the Scala Transmission Server, and Scala 

Support Server Services are Started and are set to 

Automatic. Go to Start -> Settings -> Control Panel.  Double-

click on Administrative Tools, then Services. 

 

11. Try rebooting the Content Manager system. 
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12. Check the Scala Transmission Server Service IC.log file for 

errors. 

 

13. Check the Player’s IC.log for errors. (The shortcut to the log 

folder is in the start menu). 

 

Note:  This is one of the most significant locations to 

identify issues with your system.  The most recent error 

is at the bottom of the log file. 

 

14. In Content Manager, navigate to: Network -> Players select a 

player, click the properties button, then click Configuration tab 

and check to see that the correct Distribution Server is 

selected.  If using the “Main – Point-to-Point” distribution 

server, verify the correct “Plan Delivery” setting is selected. 
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4.1 Accessing Content Manager 

 

Once Content Manager has been installed, a user will be able to 

access the system using a standard web browser from anywhere 

on the network. 

4.1.1 Local Machine Access 

 

To access Content Manager from the server, select the Windows 

icon in the bottom left side of the computer screen. Then select 

Programs from the menu list. 

 

The list of all of the programs installed on your computer can be 

accessed from this screen.  Select Scala Content Manager 5. 

The menu items will expand to include a number of items that are 

part of Content Manager.  Open Content Manager by selecting 

the red icon – Access Content Manager5. 
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You can also access Content Manager from a standard web 

browser.  The URL for your server is available from your IT or 

system administrator that installed the Content Manager system. 

A typical URL for accessing Content Manager will appear in this 

format:  http://192.168.1.1/ContentManager. 

4.1.2 Logging on to Content Manager 

 

When you first log on to Content Manager and every subsequent 

time you access the system, you will be provided with a login 

screen.  All users will need to enter their Username and 

Password in order to access the information in Content Manager. 

Note: Since much of the content in Content Manager is user 

driven and user specific and since Content Manager uses 

workflow for assignments and approvals, it is important that 

all users have separate Usernames and that Passwords are 

set according to the security policies of your company in 

order to keep content secure. 

 

http://192.168.1.1/ContentManager


    Content Manager           User Manual  

 

 

69 

 

 

Enter Username and Password and select the Login button. 

This will take you to the Scala dashboard where most of the day 

to day operations and actions using Content Manager will occur. 

4.1.3 Content Manager Dashboard 

 

The Content Manager dashboard provides a full array of 

operations for every type of user.  Based on user roles and 

access, information available and tools available within the 

dashboard will vary. 

 



    Content Manager           User Manual  

 

 

70 

 

 

 

The dashboard is divided into three distinct areas for use. 

The primary screen provides messaging and workflow activities. 

Users will be able to access approvals and messages and review 

rejected messages for re-editing. 

 

 

1 2 3 
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Menus –  

Expandable 

menus link to all 

of the program 

functions.

Primary Screen –  

Provides 

information about 

messages the 

require attention or 

approval.

Network Status –  

Plan generation and 

version of Content 

Manager.

Network Summary –  

Useful facts about 

the network.

User Manual –  Link to 

download pdf version 

of the manual.

Scala Advantage Reminder 

provides information regarding 

your subscription.

 Copyright 1993 – 2009, Scala, Inc. 

 

The left hand pane includes the menus the user will need to 

access the tools inside Content Manager. 

The right hand pane is sometimes used for summary messaging 

– when you log on, other times is assumed into the primary pane 

and most often will contain search options to assist the user in 

more effectively finding content in Content Manager. 

Select one of the message links on the primary screen of the 

dashboard.  This will advance the user to the Message Center 

where multiple actions and activities occur. 
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Complete information on Messaging is covered in the Content 

section of this guide – (5.4 Messages). 

4.2 The Settings Menu 

 

Select the “Settings” tab by clicking on the + sign on the setting 

bar.   

       

 

This will expand the bar to include those areas relevant to 

settings that the user will need to access and control. 
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Note:  Settings options are also controlled and available 

based on Roles and users will see options based on the role 

that the administrator has set for them.  The view in this 

manual is typically the role of the administrator where all 

options are available to view. 

4.2.1 Personal Settings 

 

Next select “Personal Settings” to access personal information, 

manage passwords and set regional settings.   

The Administrator username is assigned by the system  and 

cannot be changed by the user. 
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Identifying information such as first and last name and email 

address can be managed by the user. 

To change name, password or regional settings fill in the 

appropriate fields or select the appropriate drop downs and select 

Save at the top of the page.  If this operation occurred in error, 

select Cancel and the system will remain as originally configured. 

 

4.2.2 Roles 

 

Prior to adding users, it is important for users to understand the 

“roles” that they will be assigned to and how to modify roles using 

the roles tool in Content Manager. 
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Additionally, workgroups should also be configured prior to users 

being added to the system. 

 

Select the roles option in the left pane.  This will provide a list of 

available and predetermined roles in Content Manager.   

Each of those roles has a fixed set of actions that will limit what 

actions and activities the user will be allowed to take when using 

the Content Manager. 

4.2.3 System Administrator 

 

The System Administrator is a set role and the only role that 

cannot be managed.   
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It allows the administrator full access to the system.  In all other 

roles, the administrator can rename the role and change the 

actions, activities or resources available to and associated with 

that role. 

4.2.4 Other Roles 

 

Select a role other than Administrator and review the resources 

available to that role. 
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The Graphic Designer role has prescribed actions that allow that 

role to accomplish the work of a graphic designer in the Content 

Manager system. 

The list below provides a comprehensive view into all of the 

available actions and resources.   

Based on system needs, the Administrator can change and 

modify the actions and resources on a role by role basis. 

 

 

This list of roles and 

resources includes 

access to: 

Media 

Categories 
Templates 
Messages 

Playlists 
Schedules 
Channels 

Players 
Player Groups 
Workgroups 

Maintenance Jobs 
Remote Publish 
Locations 

Distribution 
Network Settings 
Network Monitor 

Health Monitoring 
User Activity 
Playback Audit Module 

Roles 

Users 
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Note:  Under Roles / Resources, the resource for reporting is 

now called Full access to Reporting, for consistency.  

The feature allowing the person who requested an approval 

to cancel the request is now called "withdrawing". 



    Content Manager           User Manual  

 

 

79 
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4.2.5 Renaming Roles 

 

To rename a role select that role in the list in the Content 

Manager dashboard middle panel.  The role name and that roles 

access will appear in the right panel.   

 

Highlight the name and type the new name that will identify the 

role. 

 

 

Select Save to save your changes or Cancel to revert back to the 

present name. 
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To change the access and resources that a particular role has, 

select the role, review the access and resources and make 

selections based on access required for that role. 

4.2.6 Workgroups 

 

Content Manager allows the user to create, edit and delete 

Workgroups.   

A Workgroup is a simple way of associating one or more users to 

a particular collection of other users.  This can be helpful in 

creating associations between content, playlists and groups of 

users. 
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Select “Workgroups” from the left panel of the dashboard in 

Content Manager.  If Workgroups have already been created 

they will appear in a list in the middle panel.   

To create a Workgroup – select “New” at the top of the middle 

panel. 

 

Define the name of the Workgroup and its description in the 

appropriate fields.  You should select names that clearly identify 

the purpose of the group.  Workgroups are assigned at the user 

level when you create a new or edit an existing user. 

 

Select Save to save the Workgroup or Cancel if you do not wish 

to save the new Workgroup. 

4.2.7 Adding Users 

 

To create new users, select New at the top of the middle panel 

on the Content Manager dashboard. 

The right hand panel will allow you to add user – assigning a 

username and password and assigning roles.  If workgroups 
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have been set up they can be assigned to a workgroup.Regional 

Settings and other Miscellaneous Settings can be applied. 

 

 



    Content Manager           User Manual  

 

 

84 

 

 

Create a username and assign the user a password.   

The user can be required to change their password when they 

login for the first time (see Miscellaneous Settings). 

Based on the setting selected by the administrator, the user will 

be able to maintain and change their passwords when they log 

onto the system. 

Enter the user’s first name and last name and email address in 

the appropriate fields. 
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Note:  Including email addresses at this point is an important 

step since player error notifications are sent out by email as 

well as shown within the Content Manager dashboard. 

Assign the user’s role by highlighting the role from the list.   

 

Assign the user to the appropriate workgroup. 

Select any regional settings from the drop down and radio button. 

Choose any miscellaneous settings that are appropriate for this 

user.   

Note: Miscellaneous settings allow the administrator to 

inactivate user accounts and control user access and 

actions around content approvals (workflow), passwords 

and email. 



    Content Manager           User Manual  

 

 

86 

 

 

 

Save the user by selecting Save from above the center panel in 

the Content Manager dashboard. 
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Users can now be managed from the center panel of the Content 

Manager dashboard. 

 

4.2.8 License Status 

 

Scala Content Manager allows you to monitor license status and 

usage from the middle panel of the dashboard. 

Select “License Status” from the list in the left panel under 

Settings.   
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The status screen provides detailed information related to your 

Scala Content Manager license including number of available 

licenses, and the modules your license contains. 

4.2.9 Hosting Server  

 

Users that have purchased the Content Manager Hosting Server 

can access multiple Content Manager sites from a single sign on. 
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The Administrator of a hosted network can access the Settings > 

Hosted Networks tab and see the licenses for each network, 

see the users of each network, as well as add and remove users 

from each network.  

When logging on to a Content Manager Hosting Server with a 

user account that is associated with multiple Hosted networks, 

the last logged-into network is presented as the default network 

to log into.  

 

This allows users to choose which network they want to log on to 

by selecting the named network and then clicking on Select 

Network. 

Users can be associated with one or multiple networks – allowing 

them to access whatever Content Manager networks to which 

they are assigned. 
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4.2.10 Adding Licenses 

 

In order to update your license for Content Manager you will need 

to contact your Scala Sales Representative.   

4.2.11 Software Updates 

 

From time to time software updates will be made available for 

download at www.scala.com/updates.  These updates are 

available for customers on software maintenance program called 

Scala Advantage.   

If your software maintenance has expired, you will not have 

access to any software updates. 

For further information related to licenses, software maintenance 

and software updates you should contact your Scala sales 

representative. 

4.2.12 Database Configuration 

 

The DB Config tool in the Content Manager dashboard allows 

you to view and modify the current database configuration 

settings.   

Select “DB Config” from the list in the left panel under Settings. 

These settings were initiated when Content Manager was first 

installed and configured.   

http://www.scala.com/updates
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Note:  Any changes made to these settings will modify the 

database and the original settings of your existing 

installation.  Changes should be made ONLY in consultation 

with or by the Network Administrator.  Complete 
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understanding of configuration options is necessary for ANY 

changes in order to maintain the system. 

4.2.13 Server Settings and Status 

 

Some Server Settings in Content Manager are not editable.   

The Server Settings Status page shows information regarding 

Content Manager’s memory usage and connection details.  

 

Maximum server memory:  This is the maximum amount of 

memory available to the Java Virtual Machine 

Free memory:  This is the amount of free memory within the Java 

Virtual Machine  

Number of processors:  This represents the number of 

processors available to the Java Virtual Machine  

 

Allocated memory: This is the amount of memory currently 

allocated by the Java Virtual Machine  

4.2.14 Connectors 
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Content Manager is able to utilize secure HTTPS connectors.   

Select the Connector tab and then choose “New”.  From the drop 

down selector.  You can choose either HTTP or HTTPS. 

 

Once you have selected either a HTTP or HTTPS connectors, 

you can use Content Manager to determine the connections. 

The HTTP configuration screen is shown here: 

 

To complete a HTTPS connection see Section 4.3. 

 

You can edit certain settings: 
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Port number - The port number the connector will bind to. You 

can only bind one connector to each port on each IP address.  

Maximum Threads – Enter the maximum number of concurrent 

threads this connector can use. The connector will not be able to 

serve more simultaneous requests than it has threads.  

The default value is 150.  

You should set this based on how many players are directly 

connected to Content Manager. To ensure stable content delivery 

this value should be set to about 4/3 the number of connected 

players. Specifying a value of more than 1000 has little effect on 

Windows Operating systems, because there is a limit to the 

number of threads available to each process. 

Max keep alive - Enter the maximum number of requests that can 

be kept alive waiting for subsequent requests on this connector. 

The default is 100, and a value of 1 disables this setting. 

Generally Scala recommends disabling this setting on networks 

with more than 50 players. 

Min spare threads - Enter the minimum number of spare threads 

for the thread pool on this connector. This setting is the number 

of threads that are available to serve requests when they arrive. 

The default value is 4. If your network contains more than 50 

players, this setting should be set to 25. 

Max spare threads - Enter the maximum number of spare threads 

for the thread pool on this connector. This setting is the maximum 

number of idle threads that can live in the pool before the server 
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begins to close them. The default value is 50. If your network 

contains more than 50 players, this setting should be set to 100. 

Enable lookups - If enabled, Tomcat will attempt to resolve the 

hostnames of clients (such as players). Enabling this setting can 

negatively affect performance. 

 

No TCP delay - If enabled, this setting generally improves 

performance.   

If you edit any of the connector settings, make sure to click the 

Save button. Then click the Restart Server button to use your 

new settings. You can create new connectors by using the New 

button.  

4.2.15 Client Connections 

 

NOTE: If you make any changes to the client connections, 

your player(s) might not be able to connect back to Content 

Manager. Meaning that you will need to reconfigure any 

existing players in the field to use the new settings!   

When you install Content Manager, the client connection settings 

are pre-configured.  

If you want to change them post installation, go to Settings > 

Server Settings and click the Client Connections tab. You can 

then edit certain settings:  



    Content Manager           User Manual  

 

 

96 

 

 

  

Virtual Folder: - The virtual folder is the path that Content 

Manager uses within the webserver. For example, the full path 

after the hostname and port would be: 

www.myhost.com:8080/VirtualFolder  

Port: - The port number the Content Manager will listen for 

requests.  

Hostname: - The hostname the Content Manager will tell players 

to connect to.  

Connection port: - The port number the Content Manager will tell 

players to connect to. If you are using port forwarding, you can 

specify a different port.  

Any changes that you make need to be saved by clicking the 

Save button. Once any changes are made select the Restart 

Server button. 

4.2.16 System Information 

  

The system information tab displays miscellaneous information 

about the Content Manager system.  

http://www.myhost.com:8080/VirtualFolder
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Software Versions 

 Operating System - Operating system version and 

architecture. 

 

 Java VM - Java virtual machine version. 

 

 Web server - Apache Web server version. 

 

 Content Manager 5- Content Manager version. 

 

System Paths 

 

 Application directory: - The path on the server to the 

directory where the Content Manager web application is 

installed. 

 

 Configuration directory: - The path on the server to the 

directory where the Content Manager configuration files 

are stored.  

 

 Data directory: - The path on the server to the directory 

where the Content Manager data directory is located.  
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 Web server directory: - The path on the server to the 

directory where the Apache Tomcat web server is 

installed. 

4.2.17 Logging 

 

The logging tab shows the location of the Content Manager log 

files and also enables you to enable or disable debugging.  

 

If you enable debugging, a dialog box will require that you 

acknowledge it.  Click OK to continue. 

 

4.2.18 Firewalls and Security  

 

Almost all data transferred in a Scala Content Manager  network 

uses HTTP. When Content Manager is installed, by default, port 

8080 will be used. If you choose the default port you must ensure 

that port 8080 is open between your Content Manager and 

Player machines.  

If you specified another port as part of the installation process, 

please be sure that port is available.  
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If you are using Windows XP or Windows 2003, Microsoft 

enables a software firewall by default. However, as part of the 

installation process, the installer asks you if it’s okay to add 

exclusions to the Microsoft software firewall.  

If you chose not to do so, you must add those exclusions 

manually. Otherwise your player(s) will not be able to 

communicate with Content Manager. For more information, 

please consult Microsoft’s Windows Firewall documentation. 

Many Anti-Virus packages also install (or have available) a 

software firewall, you must be sure that the Anti-Virus software 

firewall also allows your network traffic to pass through.  

NOTE: The FTP protocol is only used when you specify 

Player- Direct FTP. This option applies for both Content 

Manager and Player. If you are not using this plan delivery 

type, then you do not have to add exceptions for FTP. 

4.3 HTTPS Connections 

Content Manager  supports HTTPS. To configure HTTPS, follow 

the instructions below.   

4.3.1 Generate a certificate  

A certificate must be generated first. The Sun Java Development 

Kit (JDK) and Java Runtime Environment (JRE) distributions 

include the application keytool.exe that creates a certificate. 

The keytool.exe application exists in the JRE bin directory that 

Content Manager installs (JRE 1.6_03). Your installed JRE or 
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JDK bin directory might differ, so you would need to modify it to 

reflect that difference. To generate a certificate, open a command 

line and navigate to this folder:  

C:\Program Files\Java\jre1.6.0_03\bin 

 

and execute this command:  

 

keytool -genkey -alias cm -keyalg “RSA” -keystore 

“C:\Documents And Settings\All Users\Application 

Data\Scala\InfoChannel Content Manager 

5\Conf\tomcat.keystore” 

This will create a password protected keystore and add the 

certificate to it. The keytool will prompt you for information about 

the certificate:   

 Enter keystore password: – Enter the password that will 

protect the keystore. 

 

 What is your first and last name? - Enter the URL you’ll 

use when accessing the Content Manager over HTTPS. 

For example: www.yourdomain.com.  

 

 What is the name of your organizational unit? - Enter your 

department name. For example – Engineering.  

 

 What is the name of your organization? - Enter the name 

of the organization. For example - Scala, Inc.  

 

http://www.yourdomain.com/
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 What is the name of your City or Locality? - Enter the city 

or locality in which you reside. For example - Exton.  

 

 What is the name of your State or Province? - Enter the 

state or province in which you reside. For example - 

Pennsylvania.  

 

 What is the two-letter country code for this unit? - Enter 

the two letter country code in which you reside. For 

example, the United States of America is: US.  

 

4.3.2 Generate a Certificate Signing Request  

In order to make Designer publish to Content Manager using 

HTTPS, you have to have a signed certificate. But first, you have 

to generate a certificate signing request.  

To generate a Certificate Signing Request open the command 

prompt and navigate to this folder:  

 C:\Program Files\Java\jre1.6.0_03\bin  

The keytool.exe application exists in the JRE bin directory that 

Content Manager installs (JRE 1.6_03). Your installed JRE or 

JDK bin directory might differ, so you would need to modify it to 

reflect that difference. 

keytool -certreq -keyalg “RSA” -alias cm -file “C:\cm_certreq.csr” - 

keystore “C:\Documents And Settings\All Users\Application 

Data\Scala\InfoChannel Content Manager 

5\Conf\tomcat.keystore”   
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This action will prompt you to enter the keystore password before 

a certificate signing request file is generated. Once generated, 

you can then send the file: 

C:\cm_certreq.csr 

to a Certificate Authority that will create a signed certificate for 

you. Proceed to the next section to install the signed Certificate.  

4.3.3 Installing the Signed Certificate  

When you receive the signed certificate from your Certificate 

Authority it must be installed into the keystore.  The Certificate 

Authority should provide instructions for this procedure. However, 

below is some general information that might help. 

First, you must download the Chain Certificate or Root Certificate 

from your Certificate Authority, and import it into the keystore. To 

do this, open a command prompt and navigate to this folder: 

C:\Program Files\Java\jre1.6.0_03\bin 

The keytool.exe application exists in the JRE bin directory that 

Content Manager installs (JRE 1.6_03). Your installed JRE or 

JDK bin directory might differ, so you would need to modify it to 

reflect that difference. 

and type this command: 

keytool -import -alias root -file “CHAIN_CERTIFICATE_PATH” -

keystore “C:\Documents And Settings\All Users\Application 
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Data\Scala\InfoChannel Content Manager 

5\Conf\tomcat.keystore” -trustcacerts 

The CHAIN_CERTIFICATE_PATH is the full path to the Chain 

Certificate that you downloaded from your Certificate Authority. 

For PKCS#7 formatted certificate replies, the supporting 

certificate chain is included in the certificate, so you don’t have to 

install the Chain or Root certificate. 

To import your new Certificate: 

keytool -import -alias root -file “YOUR_CERTIFICATE_PATH” -

keystore “C:\Documents And Settings\All Users\Application 

Data\Scala\InfoChannel Content Manager 

5\Conf\Conf\tomcat.keystore” –trustcacerts 

Where YOUR_CERTIFICATE_PATH is the full path to the 

Certificate that you downloaded. 

For more information about these processes, go to: 

http://java.sun.com/j2se/1.5.0/docs/tooldocs/solaris/keytool 

4.3.4 Creating a HTTPS Connector  

Once a signed Certificate has been obtained and installed, you 

need to create a new HTTPS connector.   

http://java.sun.com/j2se/1.5.0/docs/tooldocs/solaris/%09keytool
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Go to Settings > Server Settings and click on the Connectors 

tab.   

Then click the New button to create a new connector.  

Select HTTPS from the Select Connector Type: drop down menu.  

You see this form:  
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When you add a new HTTPS connector, there are a number of 

options that can be set:  

Port number - The port number the connector will bind to. You 

can only bind one connector to each port on each IP address. For 

HTTPS this is usually port 443. 

IP address - This setting currently cannot be changed. 

Max threads - (Optional) Enter the maximum number of 

concurrent threads this connector can use. The connector will not 

be able to serve more simultaneous requests than it has threads. 

The default vale is 150.  

You should set this based on how many players are directly 

connected to Content Manager. To ensure stable content delivery 

this value should be set to about 4/3 the number of connected 

players. Specifying a value of more than 1000 has little effect on 

Windows 32-bit operating systems, because there is a limit to the 

number of threads available to each process. Windows operating 

systems that have 64-bit support can use more than 1000 

threads. 

Max keep alive - (Optional) Enter the maximum number of 

requests that can be kept alive waiting for subsequent requests 

on this connector. The default is 100, and a value of 1 disables 

this setting. Generally Scala recommends disabling this setting 

on networks with more than 50 players. 

Min spare threads - (Optional) Enter the minimum number of 

spare threads for the thread pool on this connector. This setting 
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is the number of threads that are available to serve requests 

when they arrive. The default value is 4. If your network contains 

more than 50 players, this setting should be set to 25. 

Max spare threads - (Optional) Enter the maximum number of 

spare threads for the thread pool on this connector. This setting 

is the maximum number of idle threads that can live in the pool 

before the server begins to close them. The default value is 50. If 

your network contains more than 50 players, this setting should 

be set to 100.  

Enable lookups - (Optional) If enabled, Tomcat will attempt to 

resolve the hostnames of clients (such as players). Enabling this 

setting can negatively affect performance. 

No TCP delay - (Optional) If enabled, this setting generally 

improves performance. 

Key alias - Enter the alias of the certificate in the keystore that 

Tomcat uses for the connector. If not specified, the first key read 

from the keystore will be used. Note: You must use the same key 

alias that you specified when you generated your self-signed 

certificate. 

Key password - Enter the password Tomcat will use when 

retrieving the certificate from the keystore. The default value is 

changeit. You must use the same key password that you 

specified when you generated your self-signed certificate. 

Keystore file - Enter the full path of the keystore file (that contains 

the certificate Tomcat should use) for this connector. If not 
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specified, the connector will use a file named.keystore in the 

user’s home directory. Note: If you followed the instructions for 

generating a self-signed certificate this path is:  

C:\Documents And Settings\All Users\Application Data\ 

Scala\InfoChannel Content Manager 5\Conf\tomcat.keystore 

Once the HTTPS connector has been configured, you should 

configure the client connections to use the HTTPS connector.  

4.3.5 Configuring HTTPS Client Connections  

Go to Settings > Server Settings and click the Client Connections 

tab. 

Change the Port: value. Typically this is the same value you 

specified for the HTTPS connector Port number setting. 

If Content Manager’s traffic is not being port forwarded, the 

Connection port: should match the Port: setting. Otherwise use a 

value your IT administrator suggests.  

Then enable the Use HTTPS: setting:  
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Save your settings by clicking the Save button. 

Click the Restart Server button to use your new HTTPS 

configuration. 
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||||| 5   | The 

Content  Menu 
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5.1 Using the Content Menu 

The Content Menu is the area where the user will upload and 

manage all content in the Content Manager system.  In this 

section we will outline how to find and upload content created in 

Designer and manage that content for use. 

Select the Media menu item in the Content drop down. 

If there are media items in the media library they will appear here.  

If this is the first time you are using Content Manager, you will 

need to add media files to the library.   

Items created using Scala’s Designer can be published into 

Content Manager. 

5.1.1 Media Files 

Media files are either uploaded directly into Content Manager or 

published to Content Manager from Designer (5.3.2 Adding 

Templates).  

To add Media files - click on Upload Files 

 

Clicking on Upload Files will open Scala File Uploader in a 

separate window. 
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Select File/Select File(s) to Upload (users can also use shortcut 

keys by selecting ALT+U) 

 

 

Select File/Select File(s) to Upload (users can also use shortcut 

keys by selecting ALT+U) 
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Double clicking on the selected file will add it to the Scala File 

Uploader or highlight the appropriate file and select the “Upload” 

tab in the bottom right corner of the Uploader.   

You can add multiple files at the same time to the Uploader to 

add to Content Manager. 

The files are now available for use. 
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Click on the Media menu item in the Content drop down to 

refresh the list of items in Content Manager. 

 

5.1.2 Configuring Proxy Server Connection 

 

The File Uploader in Content Manager is capable of utilizing a 

proxy server.  To configure the proxy server connection, choose 

Network Settings from the drop-down list in “Tools”. 

 

 

The Network Setting dialog box allows you to access the internet 

via direct connection or through a manual proxy configuration.  If 
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you select Manual proxy configuration, you will need to have a 

valid HTTP Proxy and the port location. 

 

5.1.3 Searching Media Files 

 

Managing multiple files in Content Manager can also be 

accomplished by using the Search capability in the right panel of 

the dashboard. 

Search allows the user to refine the number of files in the primary 

pane of the Content Manager dashboard.  The user can select an 

attribute based on “File Type” or “Assigned Category”.  

(Assigning categories will be covered later in this chapter). 

Selecting a “File Type” will resort and expose only those files with 

the chosen attribute.  In the example below, the selected file type 

“Video” shows only those files in Content Manager that are video 

files. 
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Each of the options: Audio, Windows Script, Flash, Image, Scala 

Script and Video will provide the user with the list of only those 

File Types in the primary pane of the Content Manager 

dashboard. 

Search can also be used to identify files by category.  However in 

order to accomplish this type of search, the file must have 

assigned properties. 

5.1.4 Assigning Properties to Media Files 

 

Select a file or files by clicking on them to highlight the file name. 

 

 

Choose Properties from the menu bar or double click on the 

selected file to open the Media Properties to edit properties to a 

media item. 
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This will allow the user to add or edit: 

Description(s) 

Categories 

Assign Workgroups 

Select or Edit the Valid and End Date(s) 

Preview the Item 

Review Object History 

5.1.5 Editing Categories 

 

Editing categories allows the user to initiate a category search for 

item in the Media Content area of the Content Manager.  This 

allows the user to more effectively tag and locate items as the list 

of media types and categories grows over time.  Select Edit 

Categories. 
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The category form will open allowing the user to name and 

describe appropriate categories for the media item. 

Select New at the top of the menu bar. 

 

Users will also be able to Add Sub-Categories by selecting a 

category by highlighting the category and selecting Add Sub-

Categories from the menu items. 

 

This will allow the user to add sub-categories using the Category 

Form.  Select Back to Form to return to the Media Properties 

toolset. 
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The user can now add a category to the Media item by selecting 

the desired category and selecting Save from the menu items to 

keep the changes.  

 

Once the Category types have been added to Content Manager, 

Media items can now be sorted and searched by selecting the 

category in the drop down under the Search section of the right 

hand pane of the dashboard. 

In this example, the media item was tagged under the category 

and therefore appears when the category is selected as a search 

parameter. 
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If you select a media item and view its properties, the dimensions 

and duration of Video files, ScalaScripts, Templates, and 

Messages are now shown in the Media Information box (image 

files only show dimensions). (You may need to Regenerate 

Thumbnail to see this information for media already present in 

your library.)  

5.1.6 Audio Ducking 

 

Certain media types support Audio Ducking, meaning the player 

can turn down the volume of other audio (typically background 

audio tracks) when another media item is playing. You can now 

specify any of the following:  
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 Mark a Media Item so that it always causes audio ducking 

when it plays.  

 

 Mark a Playlist Item so that it causes audio ducking when 

it plays. 

 

 Mark an Event Trigger or Time Trigger so that causes 

audio ducking when it plays.  

 Mark a timeslot so that it causes audio ducking for its 

duration. 

5.1.7 Deleting Categories 

 

Each media item can be associated with a category.   
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You can delete the category by selecting the name of the 

category and selecting the Delete button. 

5.1.8 Valid Dates 

 

The Content Manager Properties system defaults the valid date –

from the date that the item was added to the Content Manager.   

The system also defaults to “No end date”.  Both the “Start date” 

and the “End by date” can be adjusted.   

Select the calendar icon next to the “Start date” to adjust the 

date.  Choose the radio button next to “End by” to adjust the 

ending valid date and select the calendar to adjust the date. 

 

5.1.9 Volume 

 

Certain media items allow an additional property – “Volume”.  

This allows the user to override the volume of a selected media 

item. 
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1251823647590-integrated.mov

 

5.1.10 Preview 

The Preview icon allows the user to view the media item.   
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Note:  If the media item is a Scala script file, it must be 

associated with a player in order to preview the item. 

5.1.11 Object History 

 

The “Object history” provides details of when the item was 

created, who created the item, when the item was modified and 

who modified the item. 
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Users can return to the Media Library by selecting Media from the 

Content Menu.   

 

 

5.1.12 Adding Metadata to a Media Item 
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There are two primary types of metadata in Content Manager:  

Metadata has numerous uses in Content Manager. Users will be 

able to use metadata in conjunction with media and messages 

when creating a playlist (see 6.1 Creating Playlists).  

Media metadata matching the user selected criteria can be 

automatically added to a playlist.   

Metadata can also be attached to channels. 

 

To add Metadata to a media item, select the item from the list of 

Items by highlighting the item then select Properties or double 

click on the item to open the Media Properties tool for the item. 

Select the Metadata tab in the menu items. 
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Select the “Edit Metadata” button.  This will open the Content 

Metadata tool that will allow the user to edit appropriate metadata 

for an item. 

 

Attaching or adding Metadata to an item can be accomplished by 

adding a name in the name field of the metadata form.   

       

Next select the type of metadata from the Type drop down list 

and select the add button at the far right hand side of the Content 

Metadata tool. 

The type of metadata selected will determine the “Allowed 

Values” for the type of metadata.   

 

Selecting Integer or String as the type of metadata will provide for 

“Allowed Values” that includes “Any” or “Pick from List”. 
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When Pick from List is selected as the allowed value, you must 

Edit Pick List by selecting the button. 

Metadata item values that are integers must include integers as 

values.  Type in the integer value in the open field and select the 

+ sign to add that value to the list. 

 

String values for a pick list can include any value appropriate for 

the item including numbers or words. 
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Metadata lists can be sorted in either ascending or descending 

order by selecting the Sort asc or Sort desc buttons in Pick List 

Values dialog box. 

 

Metadata lists can be deleted by selecting the red x at the right 

below the Add button.  When the user has completed defining 

metadata types, select the “Back to Form” button on the menu 

bar. 

 

The user can now select the type of metadata to attach to the 

item by selecting any Boolean type by selecting the check box 

next to that type or by selecting the drop down for any String or 

Integer item. 

5.1.13 Advanced Information  

 

The advanced tab in the menu bar allows the user to view 

revisions of the media file, determine broadcast priority using the 

drop down menu and make the media file available as non-

scheduled content by selecting the button and adding or 

selecting a target channel. 
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5.2   Using Search 

 

If you have an extensive library of accumulated media, channels 

and players, Content Manager search capability will allow the 

user to search for specific information.  

 

This provides the user options to scrolling through lists in order to 

find the desired content.  

Content Manager contains a search function in all of the major 

category panels for Media, Messages, Templates, Playlists and 

Players. 
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Using Search allows the user to define the item they are looking 

for or entering the search term in the search box. 

Select the arrow on the right (or use the Enter key) to reveal the 

results in the list panel.  

5.2.1 Media Categories  

 

Categories are labels that can be created and assigned to media 

items, templates, messages and playlists. These labels may also 

be used to help organize and search for items that match your 

desired category.  

To create and assign categories, first select a media item to view 

its corresponding Properties. Choose Edit Categories to create or 

assign the properties.  
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If categories have not been created, then you will see the 

message in the list “No categories available”. Select the New 

button at the top of the panel to create a new category.  

 

A new Category Form panel will appear on the right side. Provide 

a name and description for your new category.  

 

Click the Save button at the top of the category panel and your 

new category name will appear in the list. When selected in the 

list column, the Category Form will appear on the right where 

edits can be made and re-saved.  

To further define your media organization, you may also create 

nested sub-categories. Simply click the Sub-Categories button at 

the top of the panel and complete the Category Form in the same 

manner as the master category.  
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When you have completed editing Categories, simply click the 

Back To Form button to exit back to the media item properties. 

5.3 Templates 

Templates are created and uploaded using Scala Designer. The 

template author has created a placeholder for text and/or 

graphics.  When published to Content Manager, it will display all 

uploaded templates which can easily be managed. 

5.3.1 Viewing Templates 

If you have already uploaded templates, the dashboard will list 

the templates available to the user.  The dashboard thumbnails 

and the template list name and details provide other identifying 

information for each template. 

 

The templates can also be found using the search tool in the right 

hand pane. 

Searching templates is limited to filtering by category. 
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Adding new templates can be accomplished using Designer. 

Before you add a template, make sure that Designer is properly 

installed and available. 

5.3.2 Adding Templates 

In order to add a template to Content Manager open the 

Designer application and select Open from the top tool bar. 
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The system will bring up a dialog box that will allow the user to 

select the existing template from any stored templates available. 

 

Select the appropriate file to add and click on the Open button at 

the bottom right side of the dialog box. 

This will bring the user back to Designer.  Choose Publish and 

select the target where you intend to publish the content and 

select OK. 

 

 



    Content Manager           User Manual  

 

 

136 

 

This will open the Publish Script details dialog box.  (For specific 

details on which options to select, please see the Designer 

manual) 

 

Once you have chosen the appropriate options, click on the 

Publish button at the bottom right side of the screen. 

 

The progress bar will show the % complete.  Once the bar is 

finished click on the Close button in the middle of the bottom 

portion of the dialog box. 
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The new Template will not automatically appear in the template 

list in Content Manager.  Click on the Templates option in the 

Content menu.   

 

This will refresh the list and will include the new template that you 

uploaded. 
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5.3.3 Creating New Templates 

Note:  Creating new templates is covered in detail in the 

Designer user manual.  This overview will not cover the 

same level of detail for creating complex new templates. 

To create a new template, select New in Designer. 

 

 

Select the Page Size in the dialog box that appears in the primary 

pane of the system. 

Click OK. 
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You can add an existing item by selecting the Add Button or go to 

the drop down menu and select Add/Add Plain Page. 

      

Clicking on the picture or the plain page will open the editing 

screen allowing the user to enter text or add content elements to 

the template. 

 

In order to bind the test to a data field you can right-click on it and 

select Bind to data field. 
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Select Preview to preview the final template. 

 

Click on the screen to Close the Preview. 

The system will provide a dialog box to ask if you want to save 

the changes.  Click Yes. 
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Choose Publish and select the target where you intend to publish 

the template to and select OK. 

 

This will open the Publish Script details dialog box.  (For specific 

details on which options to select, please see the Designer User 

Manual) 

 

Once you have chosen the appropriate options, click on the 

Publish button at the bottom right side of the screen. 
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The progress bar will show the % complete.  Once the bar is 

finished click on the Close button in the middle of the bottom 

portion of the dialog box. 

The new template will not automatically appear in the template 

list in Content Manager.  Click on the Templates option in the 

Content menu.   

 

 

This will refresh the list and will include the new template that you 

published. 
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5.3.4 Template Properties 

Select a template from the template list by highlighting it in the 

list.  You can open the template properties by either double 

clicking on the template or by selecting Properties from the tool 

bar. 

 

This will open the Template Properties options in the primary 

pane of the dashboard. 

 

The name of the Template and the folder where the template is 

stored will appear at the top of the page. 
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The properties tool allows the user to add a description of the 

template, assign it to a category and to select which 

owner/viewer workgroup to attach the template. 

The user can also edit the categories by clicking on the Edit 

Categories button in the middle of the pane.  This will take you to 

the Categories tool where you can add additional categories (see 

5.1.5 Editing Categories). 

 

5.3.5 Template Administration 

Template fields can be changed using the template fields 

administration tool. 

The user can set the field values, determine if the field is 

required, set the maximum number of characters and limit the 

maximum number of lines. 

In Template Administration, select the desired field to change and 

make the changes. 

This allows the user to manage the message templates and the 

required information as well as the field, type, required vs. not 

required, maximum character length and maximum lines for 

messages in the system. 
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Changes in the template administration will show up in the 

messages that use this template. 

 

The Message screen now shows the changes made in Template 

Administration.  The user also has the option of updating the 

preview – by clicking on the Update Preview button. 
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5.4 Messages 

Adding messages into Content Manager is an important part of 

managing content across the system. 
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Note:  Before the messaging feature can be used, there must 

be templates in the system in order to send or receive or use 

the message system. (See 5.3

 Templ

ates) 

 

In order to add a message, click New then select one of the 

templates on the primary pane of the dashboard.  

 

Once you’ve highlighted the template, select Next on the toolbar. 

The Message Name will pre-populate with the name of the 

template. 
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In this example all Message Text fields are required.   

To select the Message Media to include in the message, double 

click the box under Message Media. 

 

This will open the list of media that the user can attach to the 

message.  Select the appropriate media and click on Add Media 

on the top tool bar. 
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The Approval Request option will allow you to initiate workflow.  

Select the box – Request Approval then choose the Approver 

from the drop down list. 

 

All messages include a flag status indicator.   

Green Approved  

Yellow Approval Needed  

Red Rejected  
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Messages requiring action will appear in the Network Summary 

section on the dashboard.   

 

Select the message from the list – this will take the user to the 

message requiring action in the message section of the system.  

 

Approval-related emails include the thumbnail of the item to 

approve, and a link you can click to visit Content Manager.  

On the Messages screen, you can choose between Small and 

Large Preview size. The large size makes it easier to see all the 

details of the message.  
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To approve messages, choose the radio button for Reject or Do 

Nothing or Approve.  The system allows you to add a message. 
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||||| 6   |  THE         

PLANNING 

MENU 
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Users can start planning for publishing and playing content by 

using the Planning menu in the left hand pane on the Dashboard. 

 

The flow of media content through Content Manager is a simple 

and intuitive process. Media (videos, images and Scala Scripts) 

are published from Designer or selected inside Content Manager 

and sequenced in a Playlist.  

Once a Playlist is created, it is assigned and scheduled to a 

Frame in a Channel which then plays on a Scala Player, or series 

of Players. 

Select the + sign next to Planning to open the menu.  Playlists, 

Channels and Schedules are the items that appear.  Select 

Playlists. 
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Note:  Users will also be able to use the Search utility to 

search for and find playlists. 

6.1 Creating Playlists 

Select New from the menu items at the top of the toolbar.  This 

will allow the user to create new playlists. 

The system defaults to the Properties tab – allowing the user to 

edit or select the properties of the playlist including the name that 

you will use to identify the playlist and choose the Category to 

which the playlist will belong.  

6.1.1 Editing or Adding Workgroups 

 

To add or edit a workgroup owner, choose the Owner Workgroup 

dropdown and select the appropriate workgroup owner.  This will 

allow that workgroup to view the selected content. 
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6.1.2 Adding Media Items to Playlist 

 

Select the Items tab next to the Properties tab in the Playlist 

Properties.  Then select Add Media Item from the tool bar at the 

top of the Content Manager dashboard. 

 

Choose the item or items from the list of media items by clicking 

the item name.  You can select multiple items by clicking on the 

item in the list.   

To deselect the item you will need to click on the item a second 

time.   

Items that you have selected will appear highlighted in light blue. 
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Select Add Item(s) in the tool bar to add the item(s) to the Playlist 

Properties. 

 

The toolbar also allows you to Select All of the media items which 

would allow the user to add all of the media items to the playlist 

properties. 

Selecting cancel will not delete any items but will return the user 

to the Playlist Properties screen and cancel the actions taken 

including selecting any or all of the media items prior to adding 

them to the playlist properties. 

Once a media item or items have been added to the playlist 

properties, it will appear in the list of items. 

 

Select Save to add the media item and the system will return the 

user to the Playlist.  The media item will appear in the Playlist. 
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When creating a Playlist or Smart Playlist, a Type: selector that 

lets you choose between Media, Audio, and Data. Media is the 

default. Audio is for playlists that contain only audio Media Items 

and other audio sub-playlists. Data lets you put any type of file, 

including non-media types such as XML, into a playlist. This is 

primarily useful for playlists to be used as non-scheduled content 

playlist.  

 

Content Manager now shows the expected duration of playlists. 

 

6.1.3 Playlist Properties 

Playlist Properties allows the user to set up properties for 

playlists and develop messages around the content for playlists. 
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On the Playlists screen, when viewing Items you can select 

between small and large thumbnail size.  

 

When adding pictures to a playlist, the default duration is seven 

seconds.  
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6.1.4 Creating Smart Playlists 

  

Select the New Smart Playlist Menu item from the toolbar.  This 

will open up the Properties screen necessary to create a smart 

playlist. 

Just like with a regular playlist, enter the name for the smart 

playlist. 
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Select the Smart Playlist type by using the Type selector.  The 

choices are Media, Audio and Data.  By selecting Audio, Playlist 

Media Item Properties are not available. 

Enter an optional description in the description field. 

Choose the category for the playlist.  You can edit the categories 

by selecting the Edit Category button below the category list. 

(5.1.5 Editing Categories) 

Select the Workgroup [for additional information see: (6.1.1

 Editing or Adding Workgroups) 

If Media or Data Type is chosen, the Playlist Media Item 

Properties are editable. 
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This tool allows the user to choose or modify the duration of the 

image(s), the type of transition, and the transition duration. 

All smart playlist types can choose Playlist Item Conditions.  

Select the + sign to add conditions that the item(s) will meet.  

Options include having the item(s) meet any or all of a single or 

multiple conditions set up in the Playlist Item Conditions tool. 

 

If you select the playlist to be updated randomly, the system will 

warn you about bandwidth consumption. 

Select Save to keep the changes. 

When you select an item from the Playlist you can review the 

playlist properties, delete the playlist, duplicate the playlist or 

preview the playlist.  

Selecting Preview will result in a pop up message indicating that 

the playlist has been sent to the appropriate preview player(s). 
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6.1.5 Creating Sub-Playlists  

Sub-Playlists are nested inside each other, so you can create 

several smaller playlists which can function independently, or 

grouped together inside a larger, master playlist.  

When a Playlist is open, you can add any other playlist in your 

library as a sub-playlist.  

 

Double-click on a Playlist to open the Playlist. Select the Add 

Sub-Playlist button at the top of the Playlist panel. Then select a 

playlist from those listed in your library and click the Add button at 

the top of the panel.  

The selected Sub-Playlist is now added to your master playlist in 

the Playlist Items panel. Click the Save button to retain the added 

Sub-Playlist items. 
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6.1.6 Searching Playlists 

The Search tool in the right hand pane of the dashboard allows 

the user to search on multiple attributes of the Channels, Player 

Groups, Player Status or Modules. 

When you search for an item, either enter the name of the item in 

the search area <Enter your search here> or select the attribute 

in the lists below to narrow the search result set by the selected 

attribute. 
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6.2 Creating Channels 

 

Select the Channels menu from the left hand list.  Then select 

New from the toolbar at the top of the dashboard to create a new 

Channel. 
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This will open the Channel Details tool in the right hand pane of 

the dashboard. 

6.2.1 Channel Properties 

First choose the properties of the Channel including name and 

description.  If there is metadata available, it will appear in the 

properties tab. 

 

Note: It is important to identify properties by names that 

clearly mark the information so that it can be located using 

the search tool at a later time.  In large Scala 

implementations, the size and number of items will require 

the use of the search tool and this tool will be more effective 

when appropriate naming conventions are used. 

You will also be able to select any Player Metadata that has been 

identified or added to Players. 

6.2.2 Audiovisuals 

The Visual Properties tool allows the user to define and set the 

appropriate frames, screen size and frame properties for a 



    Content Manager           User Manual  

 

 

166 

 

channel.  The preview area will allow you to view the Properties 

as they will appear on the channel. 

Select the Frame Properties and Screen size from the drop down 

list.  The preview area will adjust based on the selected frameset 

properties.  This will allow you to visually see the results of your 

selections. 

 

If you place a check in the Controlled by Ad Manager box, the 

schedule will be only available for Ad Manager.  Check with your 

Scala authorized representative to find out more regarding Ad 

Manager. 
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When defining a channel, there are additional audio-control 

options:  

 Play separate audio track 

 Mute audio from visual media items  

  

This lets you add a separate audio track to a channel (instead of 

or in addition to any audio within the channel's visual Media 

Items), or lets you define an audio-only channel. 
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6.2.3 Channel Warning Notices 

If you delete a frame and it is used by any channel, the contents 

linked to the frame will be deleted and lost. 

 

If the frameset is changed or modified, it can affect schedules for 

the selected channel causing them to disappear. 

6.2.4 Channel Variables 

Set the channel variables by selecting the Variables tab at the 

top of the Channel Variables tool in the right hand side of the 

dashboard.  This allows you to select variables that are attached 

to the channel that can be selected in the set up of the channel.  

 

Channel Variables is the way to link a control script to a channel. 

To access Channel Variables, go to Planning-> Channels. Select 

the Channel you want to add a channel variable to, and click the 

Variables tab. Click the plus button under Name heading to 

create a new channel variable. You see this form: 
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Note:  The variable name cannot start with a digit. 

 

This form allows you to do the following:  

Name - Set a name for the Channel Variable. This name must be 

unique, and is automatically prepended with “Channel”. 

 

Type - Select the variable type you want to use. This can be 

either Boolean, Integer or String. Note that currently only Boolean 

and Integers can be used to trigger playlists. However, you can 

also share String variables between your Control Script(s) and 

Scala. 

Control Script - Content Manager automatically lists all Control 

Scripts that have been uploaded. Select the Control Script you 

want to be associated with this channel variable. 
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Shared Name - The name by which your Control Script will see 

and be able to modify this Channel Variable. It will initially be 

filled in automatically with the text used in the Name field (except 

it will not have the “Channel.” prefix - periods are not allowed in 

variable names), but it can be anything you want.  

The important part is that it must match the name of a variable 

used inside the Control Script.  

More than one Channel Variable can be linked to the same 

Control Script. Simply choose the same Control Script for each 

Channel Variable. Note that in this case, only one Control Script 

will be run. Once you have added one or more variables to your 

channel, make sure you click the Save button to keep your 

changes. 

Once you have completed setting up the Channel, select Save at 

the top of the toolbar in the dashboard to save the channel.   

You can also delete channels by select an existing channel from 

the list by highlighting the channel and selecting delete at the top 

of the toolbar in the dashboard. 

 

The name of the new channel will now appear in the list of 

Channels along with the Frameset Name. 
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6.3 Creating Schedules 

Select the Schedules item in the list in the left pane of the 

dashboard. 

 

This will open the Schedules tool in the primary pane of the 

dashboard. This tool can be used to establish schedules for 
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channels, select event triggers and time triggers for content, and 

allow for non scheduled content as well. 

On the Schedules screen, the button-bar has buttons for 

Properties, Lock, Unlock, Change Color, and Jump to Start Date. 

 

All schedules are related to their specific channel.  Select the 

appropriate channel in the drop down to create or change the 

schedule. 

 

Select New in the top tool bar.  This will open the Timeslot 

Properties tool and allow you to select the playlist and other 

timeframe information for the schedule. 

 

Timeslots can be scheduled to the nearest second. 
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Select the Playlist from the drop down menu. 

 

The system defaults to a start time of 00:00:00 and end time of 

24:00:00 – the full 24 hour period and defaults to a recurrence 

pattern of weekly on the present date with “No end date” for 

range of recurrence. 

Each of these elements can be adjusted based on the schedule 

you choose. 

In order to change the schedule properties of a Playlist, edit the 

target event – Time, Recurrence Pattern or Range of Recurrence 
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- type in the appropriate information and select OK at the bottom 

of the dialog box to save the changes entered. 

 

The new schedule pattern will now appear in the primary pane of 

the dashboard. 

Separate playlists can be selected using the dropdown. 
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Select the Schedules tab to see the time calendar of the 

schedule that you chose. 

 

Mouse over information about the schedule is available by 

scrolling over and holding on the icon on the schedule. 

 

While you can change the schedule information and properties by 

double clicking on the item in the calendar, the timing of the 
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schedule can be adjusted and changed without going back to the 

properties dialog box by using the schedule tool at the top of the 

calendar. 

 

The system defaults to the present week.  You can adjust the 

week for the schedule by using the calendar in the middle of the 

schedule tool or by moving the weeks up or down by using the 

arrows next to the present week. 

 

6.3.1 Channels That Contain More Than One Frame 

Users can utilize the tool to develop scheduling for content in 

specific areas of the screen.  This tool allows the user to 

schedule content other frames by schedule clicking the frame 

drop-down menu. 
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6.4 Triggers 

Triggers is a way to define, in Content Manager, a specific 

playlist for a player to start playing when some external input 

happens. This input comes from Control Scripts, like a VBScript 

that monitors a file or controls an external device through a serial 

port.  

Control scripts are VBScripts, JScripts or Python Scripts that are 

created using third party tools, specifically for the purpose of 

managing external conditions that you want, at times, to interrupt 

the normal playback of a frame in your channel.  

Once written, these must be uploaded to Content Manager. To 

upload a Control Script, go to Content->Media. Click the Upload 

Files button to launch the Scala File Uploader. Once the File 

Uploader has started, you can upload files by either dragging the 

control script(s) into the File Uploader window or by clicking File-

>Select File(s) to Upload. 

Once your Control Scripts are uploaded, they appear in the 

Media list tagged with Type: Windows Script. You can view all 

control scripts by expanding the File Type filter under the search 

text entry box and selecting the Windows Script entry.  

A typical control script looks like this: 
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Once you have a control script uploaded, you can then assign 

the control script to one or more channels by defining channel 

variables.  

6.4.1 Channel Variables  

Channel Variables is the way to link a control script to a channel. 

To access Channel Variables, go to Planning-> Channels.  

Select the Channel you want to add a channel variable to, and 

click the Variables tab. Click the plus button under Name heading 

to create a new channel variable.  

You see this form: 

 

This form allows you to do the following:  

 Name - Set a name for the Channel Variable. This name 

must be unique, and is automatically prepended with 

“Channel”. 

 

 Type - Select the variable type you want to use. This can 

be either Boolean, Integer or String. Note that currently 

only Boolean and Integers can be used to trigger playlists. 

However, you can also share String variables between 
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your Control Script(s) and Scala. 

 

 Control Script - Content Manager automatically lists all 

Control Scripts that have been uploaded. Select the 

Control Script you want to be associated with this channel 

variable. 

 

 Shared name - The name by which your Control Script 

will see and be able to modify this Channel Variable. It will 

initially be filled in automatically with the text used in the 

Name field (except it will not have the “Channel.” prefix - 

periods are not allowed in variable names), but it can be 

anything you want. The important part is that it must 

match the name of a variable used inside the Control 

Script.  

6.3.2 Event Triggers 

Event triggers are based on an external event that triggers 

content to be played on the player. 
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6.3.3 Setting up a Trigger  

More than one Channel Variable can be linked to the same 

Control Script. Simply choose the same Control Script for each 

Channel Variable. Note that in this case, only one Control Script 

will be run. Once you have added one or more variables to your 

channel, make sure you click the Save button to keep your 

changes.  

Playlists to be triggered are no different than regular playlists. 

However, when you created your playlists, they might not have 

met the criteria that are now needed. A playlist to be triggered is 

special because it only plays when a channel variable is 

changed. It is recommended that you create any playlists to be 

triggered now (before moving on to the next section).  

You might also want to prepend the name of any these playlists 

with “Trigger” so they can be identified easier. Once you have a 

playlist created, you can now configure it to play when the 

channel variable you set up is changed by your control script.  

Once you have uploaded your control scripts, setup your channel 

variables and created any additional playlists, the next step is to 

configure what playlist plays when a channel variable is changed. 

You do this by going to Planning -> Schedules. Select the 

Channel you created the Channel Variables for, then click the 

Triggers tab to view the triggers form.  

Below is an example that uses two channel variables (one of 

each type - boolean and integer): 
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Under each heading, you see the variable(s) details listed. Based 

on the variable type, certain options can be changed.  

6.3.4 Triggering on Boolean and Integer Variables  

Ignore if already playing - The player ignores any changes to the 

channel variable and continues to play the playlist to completion. 

Like Boolean channel variables, you can select the playlist that 

will play when the control script has changed the channel 

variable. However, any change in the value causes the playlist to 

start, and the player goes back to playing its regular timeslot after 

the playlist has played a single time.  

The Repeat Trigger Response option is available to control what 

happens if a trigger happens again while the playlist is playing. 

You have four choices: For boolean channel variables, the only 

option that can be changed is Playlist. Here you select a playlist 

to play when the Control Script changes the boolean value from 

false to true (or 0 to 1). Notice that under the heading Repeat 

Trigger Response, the value is set to Play while on. This means 

that the playlist specified will continue to play in a loop until the 

control script changes the channel variable back to false or 0. At 

that point the playlist is ended immediately, and the player goes 

back to playing its regular timeslot. 

 Restart upon change - The player will restart the playlist 

from the beginning and attempt to play until completion 
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every time the channel variable is changed. 

 

 Loop until unchanged - If one or more triggers happen 

before the playlist ends, then the playlist loops once 

instead of ending. Triggers in subsequent loops follow the 

same logic. 

 

 Loop once per change - For each trigger that happened 

while the playlist is playing, another loop of the playlist is 

added.  

A Simple Trigger Example  

 

1. Configure a player to play back in One Channel (Window) 

mode. This is necessary as the example uses Windows 

message boxes. 

 

2. Open notepad and type: 

 

Doresult = msgbox (“Play Trigger Playlist?”, vbYesNo) 

If (result = 6) Then 

MyTrigger = True 

msgbox “Press OK to stop Trigger Playlist from playing.” 

MyTrigger = False 

Else 

MyTrigger = False 

End If 

Loop 
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3. Save the file as MyControlScript.vbs 

 

4. Upload the file to Content Manager using the File 

Uploader in the Media items list. To see the benefits of 

using triggers, follow these instructions to setup a trigger: 

Once any changes are made be sure to click Save to 

keep those settings. 

 

5. Go to Planning -> Channels. Select a channel you want to 

use for this example, then click the Variables tab. 

 

6. In the name field, type MyTrigger. This should 

automatically change the Name to Channel.MyTrigger, 

and the Shared name should be MyTrigger. 

 

7. Leave the Variable Type as Boolean. Select the 

MyControlScript. vbs file you uploaded in step 4 as the 

Control Script. 

 

8. Click Save. 

 

9. Go to Planning > Schedules. Select the channel you 

added the channel variable MyTrigger for, then click the 

Triggers tab. 

 

10. Select a playlist to play when the channel variable 

MyTrigger is set to true. 

 

11. Click Save. 
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12. Synchronize player.  

 

Once the player has received the plan, and has downloaded all 

of the necessary content, you will see a Windows dialog box on 

screen. 

If you want to play the trigger playlist (that was specified in Step 

10) click Yes. To stop playing the trigger playlist while it is 

playing, click OK. To stop the player, select the player window 

and press ESC or click the window close button. 

6.3.5 Time Triggers 

The user can also setup specific content to play at a given time 

using the Time Triggers tool. 

Click on the + button to create a new Time Trigger.  The Time 

Trigger dialog is shown. 

 

Assign a name, playlist, the number of items to play.  Then set 

the time the trigger occurs (and repeat interval if necessary), the 
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recurrence pattern, and range or recurrence.  Click the Save 

button to keep the changes. 

6.3.6 Non-Scheduled Content 

Non-scheduled Content is a way for you to deliver content to one 

or more channels independently of any playlist. This is useful for 

many reasons:  

 You want to deliver a file or files ahead of time that you 

know your players will need in the future. 

 

 You want to deliver a file or files that are used by a 

VBScript or another scripting language that are not used 

in any playlist.   

 

To complete this process: Go to Planning > Schedules > Non 

Scheduled Content  

Select a media item that you want to mark as non-scheduled 

content. 

 

Select Properties.  
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Click on the Advanced tab.  

 

Under the Non-Scheduled Content section, click the Make 

available as non-scheduled content checkbox. 

Click the Select All button to select all the CURRENT channels, 

or select each individual channel in the target channels list. 

Click Save to keep your changes.  

In order for your channels to pickup any newly marked Non-

Scheduled content, you must generate a plan for any of the 

players that use that channel.  

These are a couple of important points: 
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 If you add a new channel AFTER you mark a piece of 

media as non-scheduled content, and you want the newly 

added channel to receive any of the non-scheduled 

content, you will need to edit the media item and add the 

new channel to the target channel list.   

 

 All non-scheduled content is delivered to the players 

using the same folder layout that exists in Content 

Manager. Meaning that if you uploaded a media item to a 

sub-folder called images, when the player downloads that 

media item, the player will store it in the folder: 

Content:\images.  

This is important because if you are using Designer to 

setup an image as linked content, you will need to have 

the placeholder image in the folder Content:\images 

instead of just Content:\. If this is not setup correctly, the 

player will not be able to find the media. The same is true 

if your Remote Publish Location places media in a folder 

named after the Publish Location.  

 

 Keep in mind of the bandwidth considerations when 

marking one or more media items as non-scheduled 

content. Especially if you are sending non-scheduled 

content to all your channels.   

You can very easily overwhelm your existing infrastructure if, for 

instance, you have 10 channels with 10 players on each channel 

and you mark a video file that is 1 GB in size as non-scheduled 

content. Be aware in this case that Content Manager will have to 
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transmit 100 GB of data (even though each player will only 

download 1 GB). 

 

These are just a few of the reasons why this feature can be 

useful.  

6.3.7 Preloading Content on Players  

Players support the notion of pre-loaded content. This allows you 

to pre-install content on the Player systems before putting them 

in the field, to optimize away the need for the player to download 

the content when the player connects to Content Manager.   

Note: Any pre-installed content is not available for use until 

you add it to the plan (you must put it in a playlist or mark it 

as Non-Scheduled Content).   

When the player goes to download a given file from   Content 

Manager, it first checks for an exact match in the Pre Loaded 

Content folder. If found, the pre-loaded copy is used, and the 

download is skipped.  

By default, this folder on the player is:  

C:\Documents and Settings\All Users\Application 

Data\Scala\InfoChannel Player 5\Network\PreLoadedContent  

 

The default folder can be overridden with the PreLoadedContent 

MMOS.INI keyword. For example: 

 

PreLoadedContent = “C:\MyPreLoadedContent”  
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For example, you can place a file BigVideo.mpg in this folder. If 

the player’s plan requires a file called BigVideo.mpg, and the 

MD5 signature of the preloaded version matches the MD5 

signature of the version needed by the plan, the preloaded copy 

will get used, skipping the download.   
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||||| 7   | The 

Network Menu 
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7.1 Players 

 

Users can control a number of important activities from the 

Network Menu.   

Select the + sign on the Network menu item on the left pane of 

the Content Manager dashboard and then select Players from the 

list. 

 

License information regarding available allocated and 

unallocated information is available in the primary panel of the 

dashboard. 

From this location, you will be able to add new or delete players, 

control properties and channels of players and manage other 

aspects of the player list.  Any players already added will appear 

in the primary center pane of the dashboard. 
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Once you have created channels in Content Manager, you may 

then create Players to display them. When you create players in 

Content Manager, they must also be configured on the player 

computer to be able to communicate with the Content Manager.  

On the player, the Player Configuration utility relies on the correct 

setup being established in Content Manager, so do this step first. 

This process is described in further detail in the Player Users 

Guide. Clicking on the Players button will open the Players panel. 

The first time you open this panel the list of players will be blank 

so you will have to create one by clicking on the New button at 

the top of the panel. Input the player name and description 

properties and select a channel where it will play at the bottom of 

the panel. 

The right hand pane in the dashboard will allow you to filter by 

Channels, Player Groups, Player Status and Modules. 

 

7.1.1 Adding New Players 

 

Select New from the menu items.  This will open up the tools 

necessary to add new players to the system.   
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Content Manager allows the user to manage different types of 

Player devices including Audio only players. 

These devices provide a wider range of options and types of 

players including: 

 PCs 

 PCs with Audio Only 

 IAdea High Definition Media Appliances 

 IAdea Standard Definition Media Appliance 

 IAdea Photo Frame 

 IAdea Audio Only Media Appliance 

In order for users to effectively understand how to use IAdea 

appliances, it is necessary to explain the details of installation 

and use of the IAdea Bridge Server. 

This is covered in detail in Section 7.3 including the details of 

adding IAdea players.   
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To add a PC or a PC w/ Audio Only player - use the radio buttons 

and select a Player Device Type.  The Player Properties menu 

will appear. 

 

The menu items will allow you to set the Properties, 

Configuration, Metadata, Logs and EX Modules for the player 

selected. 

 

You can Edit Player Groups clicking the Edit Player Groups 

button. 
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Select New to create a new player group. 

This will refresh the right hand pane in the dashboard with the 

Player Group Form.  Identify and complete the name and 

description of the Player Group and select Save from the menu at 

the top of the navigation bar. 

 

Once you have completed creating Player Groups, select Back to 

Form on the menu bar. 
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Now you will be able to complete the Player Properties 

information. 

 

The new player will automatically default to Enabled.  If you want 

to disable the player, deselect the box Enabled. 

If the Player is a Preview Player, check the Preview Player box.  

If you want to immediately request the logs for this player, check 

the Request logs box. 

The Display Setup tool allows the user to choose the number of 

displays that will be enabled per player – limited to 1 or 2 displays 

and to set the channel for each display. 
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Select either 1 or 2 displays – the system defaults to 1 channel 1 

screen. The screen count can be changed by entering the total 

number of screens connected to each display.  This value is used 

to determine the total number of media item playouts. 

Select Configuration from the Menu items. 

This will allow the user to set the distribution server, download 

threads and set logging levels. 

 

Select Save from the menu items. 

The new Player will be updated in the list of Players and provide 

the user with the attributes related to that player. 

The system will report the player status and indicate when the 

plan and content has been download.  See the indicator bar 

under Download column.  

The system also allows the user to identify the type of player, the 

channels the player has been assigned to, monitoring (heartbeat) 
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information about the player and information about the plan and 

download status for the player. 

Users can control the minimum amount of time unused content 

files are retained on players for reuse. This can be useful in 

reducing transmission time in cases where certain content is 

removed for a time and then re-activated (e.g., switching 

channels for demos, switching to unplanned emergency content, 

ad-hoc planned scheduling).   

 

This setting can be found in the Player configuration tab using 

the “Keep Unused Files” text entry field. 

 

Note too that the number of unused licensed players has been 

reduced by the number of players added to the system. 

You can view player logs directly from within Content Manager. 

On the Players screen, select any Player then go to the Logs 
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tab. You can double-click any log to view it. The logs themselves 

can be filtered by log-message type and log-message source.  

7.1.2 Last Heartbeat 

 

The system will automatically report back to Content Manager at 

regular intervals, with a series of “heartbeats”, to let it know it is 

still functioning properly. 

 

7.1.3 Creating Multiple Players 

 

The system allows users to create multiple players by selecting 

Create Multiple Players. 

 

If you have several players that will be receiving the same 

channel, then you can select the Create Multiple Players button 

at the top of the panel.  
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You can also enter the number of players (up to your maximum 

allowable per license) and give them a name and description.  

The name of the player must include a # symbol so it will 

automatically number each of the individual players for 

identification purposes. Select the channel which they will use, 

and click Save. 

7.1.4 Configuring Players for a Broadcast Server 

When you are configuring players for use with a broadcast 

server, you must associate the player the corresponding 

Broadcast Server and set the Player ID to match the value 

configured in the player itself.  

In the Players list, the icons in the Type column help you tell (at a 

glance) which Players are connected by point-to-point and which 

are connected via broadcast: 

Broadcast 

Player

Point-to-Point 

Player

 

7.1.5 Synchronizing Players  
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You manage synchronization of players using the Distribution 

menu. The Distribution to Players screen displays a list of 

servers which includes Main (the point-to-point distribution 

engine).  

If the Broadcast Server EX Module is enabled in your license, this 

feature allows you to define Broadcast Server(s). The 

Distribution Servers list displays the status of each server: 

 

You see the following: Synchronization status, Plan status, 

Transfer status, Remaining data to be transferred and Next 

action planned or needed.  

If changes have been made to the player’s plan, those changes 

may not be automatically sent to the player(s).  

To manually send the new plan, select a distribution server from 

this list and click the Synchronize Now button. A dialog box is 

displayed, which shows a progress bar that indicates the status 

for building the transmission.  

If you want to send the transmission without inspecting it, click 

the Send button. If you want to inspect the transmission, click the 

Inspect button.  

7.1.6 Inspecting Point to Point Transmissions  
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For point to point transmissions, when you click the Inspect 

button, Content Manager displays the Synchronize Player 

screen.  

You see a list of files (if needed), that are required to update all 

the point to point players. To update the player(s), click the Send 

button. Otherwise click the Cancel button. 

7.1.7 Inspecting Broadcast Transmissions  

 

For broadcast transmissions, when you click the Inspect button, 

Content Manager displays the Broadcast Package Builder. You 

see a list of files that are required to update all the broadcast 

players: 

 

For each item, you see the Name, Size, and the number of 

Players that have or need this file. The Transfer column shows 

the total size.  

You can selectively remove files you don’t want to send (e.g. a 

large file that’s not needed until sometime in the future.) You can 
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use the search and filter capabilities to narrow the view to the 

files of interest.  

Make any adjustments, then click Send. The display is updated 

to show the broadcast status: 

 

When a broadcast is in progress, Players receive the entire 

broadcast package before they begin the individual file 

processing.  

The transfer will progress to 100% before the first players report 

they have received the plan, and before the players report that 

they have received individual files within the broadcast.  

When players begin reporting that they have plans and media 

files, the distribution summary, and the Media Distribution Monitor 

are updated: 
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7.1.8 Broadcast Priorities  

 

You can set a Broadcast Priority to High, Normal, or Low for each 

media item. When creating a broadcast transmission, Content 

Manager automatically tags the broadcast with the appropriate 

priority. 

If a single broadcast contains files of different priority, a separate 

package is sent for each priority. Packages of higher priority are 

processed first, sent first, and received first. This can be used to 

down prioritize large media not needed urgently, and up prioritize 

files that need more rapid updates: 

 

7.1.9 Deleting Players  

 

If you no longer need a player, made a mistake in creating one, 

or just need to free up room for new players, you can simply 
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delete them from the list. Select the player you wish to delete and 

click the Delete button at the top of the panel.  

A dialog asking you to confirm the deletion will pop-up. 

 

 

NOTE: Once a player is deleted, new plans will no longer be 

generated for that player. However, if the player is not 

decommissioned, the player will continue to play its content 

for 30 days. After 30 days, the player will no longer play any 

content until it receives a new plan. 

7.2 Player Health 

The Player Health tab provides detailed information about 

problems and network activity.  
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The Player Health summary screen allows the user to access 

any errors that have been reported by player(s). 

Once you have a player configured and running a scheduled 

plan, you can monitor the player’s “health” and network activity. 

You can configure the player to send a “heartbeat” at 

predetermined intervals so the system will recognize that it is still 

operating efficiently. 

 

If the player does not send a heartbeat signal at a predetermined 

time, an optional email can be sent to one or more users. You 

could then create a new maintenance task, for instance, to reboot 

the player. 

7.2.1 Uncleared Problems 
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By default, Content Manager lists every problem that has not 

been cleared from Content Manager. To view more details about 

a problem, select the problem, and click the Details button. 

To clear a problem, select the problem and click the Clear button. 

Note that clearing the problem in Content Manager does not fix 

the problem which has occurred with the player. It simply 

removes the item from the Uncleared problems list.  

You must resolve the problem on your player, otherwise the 

problem will reappear in Content Manager at a later time. To 

clear all problems, click the Clear All Problems button. 

7.2.2 Problem Details  

 

The Problem Details screen contains detailed information about a 

problem that has occurred on one or more players. This 

information should be used to diagnose a problem with a player 

on your network. A problem detail contains: 

 Summary – The type of problem that has occurred. 

 

 Description – A description of the problem. 

 

 Details – Detailed information about the error. This 

information is very useful when contacting Scala 

Technical Support. 
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7.2.3 Cleared Problems 

To view cleared errors, click Cleared Errors in the State filter.  

The Cleared Problems lists all problems that have been cleared 

using the Clear or Clear All Problems button(s). 

Double-clicking an entry in the Player Health summary leads to 

the Player Health Problem Details screen.  

7.2.4 Searching for Problems 

 

Navigating to Network > Player Health allows the user to search 

for over 70 specific problems as well as searching for problem 

states. 
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7.2.5 Network Activity 

 

The Network Activity tab gives you the ability to see exactly what 

your player(s) have been recently uploading and downloading. 

The list currently contains a maximum of fifty (50) entries. There 

are four columns that show this information. 
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 Icon – This column reveals a visual representation of the 

action that has occurred. A few samples are: Checked 

Plan, Heartbeat, and New Plan. 

 

 Player – This column lists the player name as defined in 

the Network > Players list. 

 

 Time – This column lists how recently the specific event 

occurred. 

 

 Message – This column lists a text based message of the 

action that has occurred. 

7.3 IAdea Bridge Server Setup and Installation 

 

IAdea Bridge Server is an optional add-in module to Content 

Manager. You need to install Bridge Server when you connect 

IAdea players to Content Manager. 

7.3.1 Introduction  

 

The following contains instructions to set up IAdea Players for 

management with Scala Content Manager Release 5 software. 

You will need the following:  

From IAdea or Partners, one of the following products: 
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Note:  Set up requires installing the Scala Content Manager 5 

Release 5, enabling the IAdea Bridge Server, and adding an 

IAdea Player to the system.  

7.3.2 Installing Content Manager 5 with Bridge Server  

 

In Content Manager navigate to Network > Distribution, click New 

Bridge Server (IAdea) to register an IAdea Bridge Server.  

 

Click the Save button to keep the IAdea Distribution server you 

just added.  You can modify the settings later. 

Run the IAdea Bridge Server installer included with Scala 

Content Manager 5. 

 

After Bridge Server installation, the IAdea Bridge Server 
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Configuration utility pops up asking for Content Manager’s 

location. Enter the Server URL that points to your Content 

Manager, followed by Username and Password.  

Then click the Connect button.  

If connection is successful, the utility displays a list of Bridge 

Servers. Select a Bridge Server to associate with this installation. 

Then click Save settings and close the utility.  

 

After configuration, point your browser to the Bridge Server at 

http://server:port/BridgeServer (replacing server:port with actual 

alpha-numerical values) and you should see the following page:  
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7.4 Configuring IAdea Bridge Server 

 

Bridge Server can be used in one of two configurations: 

centralized mode and distributed mode. 

7.4.1 Centralized Mode 

 

In centralized mode, Bridge Server is co-located with Content 

Manager. It directly shares the Apache Tomcat server with 

Content Manager. This is the simplest mode of operation and 

recommended for general applications.  

7.4.2 Distributed Mode 

 

In distributed mode, multiple Bridge Servers are installed on 

separate computers as “site servers” near the players. This 

allows distributing the computation and communication load on 

the Bridge Servers to multiple server computers. 
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7.4.3 Configuring Content Manager 

 

Before installing Bridge Server, the user needs to add an “IAdea 

Server” to Content Manager. During the installation of Bridge 

Server, user must identify this IAdea Server to link Bridge Server 

to the Content Manager. 

Note:  When using Content Manager with IAdea players, the 

Content Manager “server name” must NOT be in WINS 

format (looking like “MYCOMPUTER”) but MUST BE in either 

IP domain name (“server.site.com”) or IP address 

(“72.168.12.24”) format that the IAdea player can resolve 

from its location. IAdea players are unable to perform WINS 

name resolution. 

Installation Note: 

To install Bridge Server on a computer, run the installation 

software package. 

The installer detects the presence of Apache Tomcat server. 

Version 5.5 or later is required. If one is not found, a link is 

provided to allow the user to download and install the software 

before continuing installation. 

After installation, the system automatically runs the Bridge Server 

Configuration Tool which requires the user to register an IAdea 

Server (configured in the previous section) that represents the 

installed Bridge Server. The user is prompted to enter a Content 

Manager URL, user name, and password. The Configuration Tool 

then logs into the Content Manager and retrieves a list of 
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registered IAdea Server records. The user needs to select one 

that will be used to identify this Bridge Server installation. 

7.5 Configuring IAdea Players 

7.5.1 Adding IAdea Player to Content Manager 

 

Content Manager allows the user to select from four new types of 

players: IAdea HD, IAdea SD, IAdea Photo Frame, and IAdea 

Audio-only. Steps to add an IAdea Player is similar to adding a 

standard Scala Player. 

 

Once configured, click the save button to keep the changes. 

7.5.2 Configuring the IAdea Player Device 

 

Please consult the user’s manual for your IAdea SD, HD, Photo 

Frame, or Audio-only player device for specific instructions on 

configuring Bridge Server and IAdea Player. 
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7.5.3 Troubleshooting  

 

1. The IAdea player is blank or is not showing content 

 

a. Make sure your IAdea player has a firmware that supports 

Scala software. The required minimum firmware version 

numbers are listed below. Contact support@IAdea.com to 

receive the latest available firmware for your device.  

i. IAdea HD Player: 1.0.8b or later  

ii. IAdea SD Player: 1.5.6.b5 or later  

iii. IAdea Digital Signboard: any version  

b. IAdea players default to requiring a DHCP network 

(dynamic IP assignment). Make sure the network you are 

connecting to supports DHCP, and it does not limit access 

to approved devices only. Ask your network administrator 

if you are not sure.  

 

c. If you are installing on a machine different from your 

Content Manager, make sure your Windows firewall 

allows external access to the server port you are using. 

 

d. After you added an IAdea Player to Content Manager, you 

need to “synchronize” your player at least once so a “plan 

file” is generated for your player. In Network/Players, 

select your player and click the “Synchronize” button.  
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e. The player is likely to be downloading media files from 

Content Manager. Please wait 3 to 5 minutes for the 

update to complete  

 

f. VERY OFTEN, the configuration in Content Manager sets 

the server name to a WINS name (e.g., MYCOMPUTER) 

instead of an IP domain name (my.server.com) or IP 

address (192.168.0.100). The IAdea Players are unable 

to resolve WINS names. As a result they will not be able 

to find any of the media files and will never complete 

downloading. Change the Content Manager name to 

either an IP domain name or IP address to solve the 

problem. 

 

g. If none of the above works, it is possible that your recent 

firmware update has failed. Check to ensure you have 

downloaded the complete firmware file and try updating 

again.  

For Further Assistance  

Should you encounter issues not addressed in this document, 

please contact support@IAdea.com. 

7.5.4 Looking for a Heartbeat from IAdea Player 

 

After the IAdea player starts up, you should see a sign of 

heartbeat in Content Manager.  

mailto:support@IAdea.com
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This indicates that everything is working well. If you do not see 

this, you may take a number of steps to correct the problem. 

 

7.5.5 IAdea Bridge Server Performance Tuning 

 

A number of parameters are available for global performance 

tuning for a network consisting of multiple Bridge Servers.  

Bridge Server 
Option 

Description 

Plan Refresh 
Interval   

Controls how often Bridge Server polls for plan 
changes. Set this to a large number to reduce network 
load, and a small number if you want accurate status 
indication. 

Log Level  Controls how detailed Bridge Server records its 
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Bridge Server 
Option 

Description 

activities. 
Minimum Schedule 
Expansion  

Sets the minimum number of days a plan is expanded 
into raw format to conserve memory for the IAdea SD 
Player. Players must be allowed to refresh its plan 
within this period after the last schedule expansion. For 
other IAdea Players, this value is ignored 

Schedule 
Expansion Time  

Sets time of day at which schedule expansion is 
performed to lengthen the valid period of the 
translated plan. 

Plan Retry Interval  Sets the time interval to retry downloading a plan file 
after a previous attempt fails. Set this larger than Plan 
Refresh Interval to avoid network congestion due to 
heavy network load. 

Player Heartbeat 
Interval  

Sets the time interval between successive heartbeat 
signals from players. Set this to a large number to 
reduce network load. 

Heartbeat Retry 
Interval  

Sets the time interval to retry sending a heartbeat 
signal after one fails. Set this larger than Player 
Heartbeat Rate to avoid failures due to heavy network 
load. 

Plan Status Report 
Retry Interval  

Sets the time interval to retry sending a plan status 
update after one fails. Set this to a large value to avoid 
failures due to heavy network load. 

 

For further information, product updates and support, visit 

http://www.IAdea.com/BridgeServer/. 

7.6 Maintenance Jobs 
 

Select Maintenance Jobs from the left hand navigation.  The 

navigation tools will appear in the primary pane of the dashboard.   

http://www.iadea.com/BridgeServer/
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7.6.1 Creating a New Maintenance Job 

 

Select New in the top tool bar to create a new maintenance job. 

 

Creating a new maintenance job is available for both Scala 

Players and IAdea players.  Select the desired type of 

maintenance job using the radio button and select Next. 

 

Create an appropriate name and description for the job. 

 

This will open the maintenance job Information tool. 
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Name the new job and its description and select Next. 

7.6.2 Adding Tasks for Scala Players 

Select the Tasks tab in the Create New Maintenance Job tool. 

 

This will allow the user to choose a number of tasks to complete 

and the schedule including Deleting Files, Installing Files and 

Installing System Files, in which each case a file must be 

selected to delete or install. 
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Installing software updates. 

 

Software updates are an important step in keeping your players 

healthy and ensuring any new features are readily supported. 

NOTE: Your Scala Advantage contract must be current in 

order to apply the latest software updates. This is controlled 

via the software license.  

To check if your license is current, go to Settings >License 

Status. If your license is current, create a software update job by:  

1. Clicking the Upload Files button. In the resulting dialog, 

Click File > Select File(s) to Upload… Using the Windows 

file dialog box, browse to the location where the software 

update exists. Select the file, and click UPLOAD. Once 
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the file has completely uploaded, close the file uploader 

by clicking the File > Quit, then click OK to exit the file 

uploader. 

 

2. Click New button. 

 

3. Type a Name for the job and an optional Description. 

 

4. Click the Next button. 

 

5. Under Task Properties select Install software update from 

the Task Command drop down menu. 

 

6. Select the software update you want to install. 

 

7. If the player is NOT using an account that has 

administrator privileges, enter account details for a user 

that does using the Run as user and Run as password 

text entry fields. 

 

8. Click the Add Task button. 

 

9. Click the Scheduling tab. 

 

10. Under Schedule Properties, select the appropriate option 

in the Schedule Type drop down menu. 

 

11. Click the Add Schedule button. 

 

12. Click the Players tab. 
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13. Select the Players you want to update. 

 

14. Click the Save button.  

NOTE: The Install Software Update task automatically 

reboots the player machine. Therefore, you do not need to 

add a reboot task to the job. 

Rebooting, retrieving content or running a command 

 

7.6.3 Setting the Schedule 

Maintenance Jobs can be schedule to occur or for recurrence 

based on a number of selected criteria.  Choose the Scheduling 

tab in the Create New Maintenance Job tool. 
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Depending on the Schedule Type, which the user can select 

using the drop down, the form will open to assist the user to 

adjust and schedule the maintenance job. 

 

7.6.4 Selecting Players 

The user can select which players the maintenance job will occur 

against.  Select the Players tab in the Create New Maintenance 

Job tool and choose the correct players for the job. 

 

To save the Maintenance job select Save at the top tool bar on 

the dashboard. 

7.6.5 Adding Task Properties for IAdea Players 
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Maintenance jobs for IAdea players allow the user to install all 

firmware updates.  Select the install option. 

 

Scheduling is limited to ASAP. 

 

7.7 Publish Locations 

Select Publish Locations from the left hand navigation in the left 

hand pane of the dashboard and then select New at the top of 

the tool bar. 
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The Edit Remote Publish Locations form allows the user to select 

the location to where remote content can be downloaded. 

Select the Connection drop-down menu to determine what type 

of connection is used by Content Manager to retrieve the content.  

The choices are FTP and UNC.   

 

For FTP, this form is shown: 
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Once the Remote Publish Location details have been entered, 

test the connection by clicking the Test Connection button at the 

bottom of the page. 

A dialog box will open to inform the user of the success of failure 

of the action. 
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Click OK, then click Save to keep the changes. 

By clicking selecting a Remote Publish Location and then clicking 

the Log Watcher button, details are shown regarding the current 

status of the remote publish location. 

 

Remote Publish Locations lets you specify that their Media Items 

are automatically approved.  

 

7.8 Distribution 

The Distribution panel enables you to monitor and control 

distribution of content on your network using Broadcast Server. 
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You will need to obtain a proper license and have Scala 

Broadcast Server installed and configured. 

7.8.1 Creating a Broadcast Server  

To create a broadcast server, click the Distribution button under 

the Network menu. 

Click New Broadcast Server. The following screen is displayed:  

 

 

Enter name that you can use to easily identify the server and 

optionally enter a description for the server. 
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Configure the settings for your server: 

 

When using the IP Multicast driver you can select either Content 

Manager direct for the Plan Delivery or Push to Broadcast 

Server. 

Select the Driver tab and enter the Server Transmission IP 

address.  

Most of the other attributes are standard can remain set on the 

defaults or can be adjusted according to the user’s needs. 
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You can set the schedule using the schedule tab to either manual 

mode or automated mode. 

 

The Broadcast Server Properties supports setting the Player 

Broadcast Cache Size.  

This governs the amount of broadcast data that a player will 

retain, which can be useful to resolve files that arrive out of order 

through the use of Linked Content, non-scheduled content, and 

manual addition and removal of media items from broadcasts.  

7.8.2 Defining Broadcast Server Properties  

 

1. Select the broadcast server you require. 

 

2. On the Properties tab, choose the driver type you require 

from the Driver Type list. You can choose from: 

 

 IP Multicast (see , IP Multicast) 

 File Delivery (see , File Delivery) 
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 HughesNet (see , HughesNet) 

 

3. Define how the players communicate with the Content 

Manager by choosing a delivery method. You can choose 

from: 

 

 Content Manager Direct - the Broadcast Server 

connects in to Content Manager to get its instructions. 

 

 Push to Broadcast Server - Content Manager 

delivers the instructions to the Broadcast Server. For 

Server Address, specify the local folder or FTP 

location where the Broadcast Server can be reached. 

For FTP folders, use the syntax 

ftp://user:password@hostname/path 

7.8.3 IP Multicast  

When you create Broadcast Server using the IP Multicast driver, 

you can specify the following options on the Driver tab: 
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Network Options  

 Group IP: The multicast group IP address that this 

server will transmit on. 

 

 Group port: The port number this server will transmit 

on. 

 

 Server Transmits on IP: If the server has multiple IP 

addresses, use this field to specify the IP address that 

is used when sending transmissions. You can leave 

this field blank if the server has only a single IP 

address. 

 

 Server listens on port: The port the server listens for 

incoming connections. 

 

 Packet size: The size of the multicast packets sent by 

this server. This value needs to be smaller than the 

MTU size of the network. 

 

 Time to live: The time to live for packets sent by this 

server 

 

 Bandwidth limit: The maximum data rate at which 

this server will broadcast. 

 

 Control interval: The interval at which broadcast-

control messages are sent. 
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 Control redundancy: The degree of redundancy for 

control messages  

7.8.4 Broadcast Confirmation Options  

 

Broadcast Confirmation Options Players report back which data 

blocks they have received or missed. In Confirmed Mode (the 

preferred choice), the Broadcast Server relies on these 

confirmations to automatically determine what to resend and 

when.  

The settings limit the number amount of data that will be resent, 

the number of retries of a given player before the server gives up 

on that particular player, and so on. 

When you set up the players using the Player Configuration tool, 

you need to ensure you use matching values for the multicast IP 

(“ippipe”) settings.  

7.8.5 File Delivery  

When you create Broadcast Server using the File Delivery driver, 

you can specify the following options on the Driver tab: 
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The Package Upload URL specifies where the package file is 

uploaded. Use a full URL in the following format:  

ftp://username:password@hostname:portnumber/folder  

7.8.6 HughesNet  

 

When you create Broadcast Server using the HughesNet driver, 

you can specify the following options on the Driver tab: 

 

The options include:  

 

 URL where broadcast packages are to be uploaded to the 

HughesNet Enterprise Package Delivery Server 

 

 URL to the XML status interface of the HughesNet server 
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 “Best Effort” mode, and count 

 

 FEC (forward error correction) overhead 

 

 Account-information for the HughesNet server  

 

When you set up the players using the Player Configuration tool, 

you need to ensure you use matching values for the HughesNet 

settings. 

7.8.7 Media Distribution Monitor 

The media distribution monitor allows the user to monitor the 

distribution of content in the network. 

Select the Media Distribution Monitor tab.  The user will then be 

able to monitor the name, size, players to which the content is 

distributed and the transfer of that content. 
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The search tool allows the user to show completed files in the 

media distribution monitor screen - by type, channel and time 

limit ranges. 

7.8.8 Sync History 

The sync history tab allows the user to see the history of content 

that has been synced to players. 

 

7.8.9 Editing Pending Broadcast Jobs 

 

It is possible to editing a pending broadcast job.  Navigate to 

Network -> Distribution, then select the appropriate Broadcast 

Server and click the Broadcasts tab.  Then select the broadcast 

job, and click the Edit button. 

When editing a pending broadcast, there is a Players tab, where 

the user can view the Players associated with a given broadcast, 

and optionally add or remove Players from that list.  

When editing a pending broadcast, there is also a Media tab, 

where the user can view the Media Items in a given broadcast, 

and optionally add or remove Media Items from that list.  
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When editing a pending broadcast, you can change the 

schedule of when this broadcast has been sent, and you can 

edit or re-run an existing broadcast.  

7.9 Network Settings  

Content Manager allows you to view and modify various settings 

for your Network.  

 

Click on Network -> Network Settings to view the groups of 

settings. 

If you make any changes, be sure to click the Save button in the 

button bar so your changes are committed.  

7.9.1 Approval Settings  

You can enable message approval by checking the Enable 

message approval option.  
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When enabled, you can request approval of messages before 

they are shown on a player. If the option is not enabled, then the 

messages will not require approval before being shown on a 

player.  

Content Manager also allows you to set approvals at the media 

item level. 

Select the appropriate box in order to activate the approval 

settings. 

7.9.2 Miscellaneous Settings  

 

The Miscellaneous Settings allows for further customization of 

Content Manager.  Users can choose to change the maximum 

number of threads downloaded from remote publish locations. 

 

Max Threads – The maximum number of threads that are 

available for use to download from a remote publish location. The 

default value is one (1). If you change this setting, you MUST 

stop/start the Apache Tomcat service in order for the new setting 

to take effect. 
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First day of week – Allows you to select the first day of the week. 

The two choices are Sunday or Monday. The default value is 

Sunday. 

7.9.3 Player Authentication 

The player authentication settings are the username and 

password that your player(s) use when connecting to Content 

Manager. 

 

Player username – The username player(s) use to connect to 

Content Manager. The default value is player_<networkname>. 

 

Player password – The password player(s) use to connect to 

Content Manager. The default value is scala. 

 

Confirm password – Requires you to re-enter a password for 

confirmation. The default value is scala. 

 

7.9.4 Mail Server Settings 

The SMTP settings allow you to configure Content Manager to 

use a mail server to send you an email when a player problem 

occurs. The settings are: 
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SMTP server address – The IP address or machine name of the 

SMTP server you want to use. 

 

SMTP server port – The port of the SMTP server. The default 

value is twenty-five (25). 

 

Email sender address – The email address that will appear in the 

From line of the email. 

 

SMTP username – If the mail server requires authentication, 

enter the username. 

SMTP password – If the mail server requires authentication, 

enter the password the account. 

Confirm password – Requires you to re-enter a password for 

confirmation. 

7.9.5 Web Services 

The web services authentication settings are the username and 

password that the Scala Playback Audit Parser and/or third party 

application uses when connecting to Content Manager. 

Username – The username used to connect to Content Manager.  

This username must be unique. 
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Password – The password used to connect to Content Manager. 

 

Confirm password – Requires you to re-enter a password for 

confirmation. 

 

7.10 User Activity  

Content Manager logs when any user has logged into the web 

interface. It also logs any changes that may have occurred.  

 

Click on Network > User Activity to view the list. This list contains 

four columns: 

 

 Username – The username of the person. 

 

 Type – The type of action that was performed. 
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 Object Reference Name/Identifier – The object that was 

changed. 

 

 Time – The time the action was performed. 
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|||||| 8  Advanced 

Topics 
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8.1 Backing Up Content Manager’s Data  

This chapter describes how to backup and restore Scala   

Content Manager 5. Databases currently supported are:  

 PostgreSQL 8.2.x or 8.3.x 

 MySQL 4.1 or 5.0 

 Microsoft SQL Server 2000 

 Microsoft SQL Server 2005 

 Microsoft SQL Server 2005 Express  

Content Manager does not contain an automated backup/restore 

feature, so these instructions comprise a set of manual steps.  

These steps could be automated, but are beyond the scope of 

this User Guide. The backup process assumes that you have 

copied or archived the necessary files from the Content Manager 

system to another location.  

The restore process relies on either copying or extracting the files 

from the backup location to the original location. Scala does not 

make recommendations as to where your backup files should 

reside. However, it is assumed good backup principles are 

followed.  

8.1.1 Backup Instructions  

 

Follow the five steps outlined below:  
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Step 1: Stopping Apache Tomcat and Transmission Server 

services  

Since the backup process is not an integrated part of Content 

Manager, the Apache Tomcat and Transmission Server services 

have to be stopped first. Go to Start -> Control Panel then 

double-click on Administrative Tools. Double-click on Services, 

and then find the Apache Tomcat service. Right-click and select 

Stop. Wait for the service to stop completely. 

Find the Scala Transmission Server service. Right-click and 

select Stop. Wait for the service to stop completely before moving 

to the next step.  

Step 2: Backing up the data files 

 

All data files must be backed up. By default, the location of this 

directory is: 

 

C:\Documents and Settings\All Users\Application 

Data\Scala\InfoChannel Content Manager 5\Data 

If your data location differs the one listed above, you can find the 

location in Content Manager under Settings-> Server Settings-> 

System Paths frame-> Data root. You should backup all files, 

folders and subfolders from this directory except the folder WEB-

INF.  

Step 3: Backing up the configuration files 

The following configuration files must be backed up. By default, 

the location of this directory is: 
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C:\Documents and Settings\All Users\Application 

Data\Scala\InfoChannel Content Manager 5 

 

You must backup these files and folders/subfolder within:  

 Conf – All files and subfolders 

 License – All files 

 Logs – Not necessary, but you might want to keep the log 

files 

 SavedValues – All files and subfolders 

 License.xml – The license file 

Note: The default location of the data files exists in the same 

location as the configuration files. So if you are using the 

Content Manager 5 installation default values, you can 

combine step 1 and step 2.  

You must also backup the configuration files for the Transmission 

Server. By default, the location of this directory is: 

 

C:\Documents and Settings\All Users\Application Data\Scala\ 

InfoChannel Transmission Server 5 

 

All files and subfolders should be backed up. 

Step 4: Backing up the database  
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Depending on the type of database server you are using, a 

different set of instructions are required in order to backup the 

Content Manager 5 database. You should only read and follow 

the instructions for the type of database you are using. 

Step 5 – Start Apache Tomcat  and  Transmission Server 

services  

The backup process is now complete. You can start Apache 

Tomcat and Scala Transmission Server services. 

Go to Start -> Control Panel then double-click on Administrative 

Tools. Double-click on Services, and then find the Apache 

Tomcat service. Right click and select Start. Wait for the service 

to start completely. Find the Scala Transmission Server service. 

Right-click and select Start. Wait for the service to start 

completely. You can now access Content Manager 5. 

8.1.2 PostgreSQL  

 

Backing up the PostgreSQL database is performed by either 

using the pgAdmin tool or the command line tool pg_dump.exe.  

A detailed explanation of the procedure using the pgAdmin tool 

follows as well as a short example of pg_dump.exe usage. The 

following steps illustrate the step-by-step process of performing a 

backup of a PostgreSQL database schema cm_01.  

Open the pgAdmin tool by navigating to Start -> Programs -> 

PostgresSQL 8.3 -> pgAdmin.  
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Note: There is a significant performance increase in running 

pgAdmin from the same computer that the PostgreSQL 

database server is running on.  

Connect to your database server using the same Username and 

Password you entered when you installed Content Manager 5. 

Select the database schema you want to backup, then right-click 

and select Backup. 

 

Set the backup options in the backup dialog, choose a path and 

filename for the backup file, and press OK to start the backup. 
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Verify the result. Wait for the backup process to finish, and verify 

that the final message is “Process returned exit code 0”. If the 

exit code is different, this means that the backup was not 

successful. 
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Using command line you may choose to use the command line 

tool pg_dump.exe to backup the database. To create the same 

backup as shown above, execute the following command: 

pg_dump --format=custom --compress=5 -U postgres -W cm_01 

> C:\tmp\backup\db.backup 

Please refer to the PostgreSQL manual for more details when 

using the command line tools.  

8.1.3 MySQL  

 

A backup of the MySQL database can be done either through the 

MySQL Administrator interface or using the command line tool 

mysqldump.exe. Detailed instructions on how to use MySQL 

Administrator are provided here, as well as a short example of 

mysqldump.exe usage. 

Note: A backup created using MySQL Administrator cannot 

be restored using mysqldump and vice-versa. 

The following steps illustrate the step-by-step process of 

performing a backup of a MySQL database schema cm.  

First, create the backup project, by connecting to your MySQL 

database server and select Backup from the left menu. Then click 

New Project, and give the project a name. 
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Select the cm database schema, and click the > button to select 

the contents of the schema.  

All tables should be selected. 
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The Backup Execution Method must be set to InnoDB Online 

Backup. Scala recommends that the other options remain 

unchanged. 
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Execute the backup and verify the results. Click the Execute 

Backup Now button, and verify that the backup completed 

successfully: 

 

Using command line You may choose to use the command line 

tool mysqldump.exe to backup the database. To create the same 

backup as shown above, execute the following command: 
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mysqldump -u root -p cm > C:\tmp\backup\cm_backup.sql 

Please refer to the MySQL manual for more details for the 

command line tools.  

8.1.4 Microsoft SQL Server 2000  

 

A backup of the Microsoft SQL Server 2000 can be performed 

using the Microsoft SQL Server Enterprise Manager. There are 

many different types of backup tools available for Microsoft SQL 

Server 2000.  

However, this guide only demonstrates how to create a single 

complete backup. If your networked database uses Microsoft 

SQL Server 2000, you are likely to use a more sophisticated 

(incremental) backup policy. Please consult the Microsoft SQL 

Server 2000 documentation or your database administrator for 

more information.  

The following steps illustrate the step-by-step process of 

performing a backup of a Microsoft SQL Server 2000 database 

schema cm. 

Create the backup project by connecting to your database server 

using the Microsoft SQL Server Enterprise Manager, and start 

the Backup Database wizard. 
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Select the database you want to backup, and add at least one 

destination for the backup.  

Set the Overwrite option to Overwrite existing media, if you don’t 

want to keep previous backups. Also make sure the Backup 

option is set to Database – complete to ensure a complete 

backup is performed. 
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Scala recommends that the default options remain unchanged. 

Execute the backup by pressing the OK button, and verify that 

the backup process completed successfully. 
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8.1.5 Microsoft SQL Server 2005  

 

A backup of the Microsoft SQL Server 2005 can be performed 

using the Microsoft SQL Server Management Studio. There are 

many different types of backup tools available for Microsoft SQL 

Server 2005. 

However, this guide only demonstrates how to create a single 

complete backup. If your networked database uses Microsoft 

SQL Server 2005, you are likely to use a more sophisticated 

(incremental) backup policy.  

Please consult the Microsoft SQL Server 2005 documentation or 

your database administrator for more information. 
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The following steps illustrate the step-by-step process of 

performing a backup of a Microsoft SQL Server 2005 database 

schema cm. 

Connect to your database server using Microsoft SQL Server 

Management Studio, and select the database you want to 

backup. Choose Back Up as shown below. 

 

Choose one or more destinations for the backup. Scala 

recommends that the other options remain unchanged. 
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On the Options page, select Overwrite all existing backup sets if 

you want to overwrite old backups. Scala recommends that the 

other options remain unchanged. 
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Press the OK button to start the backup. If the backup was 

successful you will see this message. 

 

8.2 Restoring Content Manager’s Data   

 

By following the steps below, you can restore your Content 

Manager data 5 from a backup. There are many reasons for 
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performing a restore. For example: you are recovering from a 

system crash (data loss) or reverting changes to the data. 

8.2.1 Restore Instructions  

 

Step 1: Perform a new install 

If you’re restoring to a system that already has Content 

Manager 5 installed, you must uninstall it first. Then you must 

delete its data and configuration files directories. You will also 

have to delete the configuration files directory for the Scala 

Transmission Server. Once completed, install the version of 

Content Manager that matches the one you have backup 

data for. At the end of the installation the installer will 

automatically open the welcome page in the browser for you.  

DO NOT configure Content Manager! Instead, close the 

browser.  

Step 2: Stop Apache Tomcat and Scala Transmission 

Server services  

The installer automatically starts Apache Tomcat and the 

Scala Transmission Server services, so you must stop them 

before proceeding with the restore process. Go to Start -> 

Control Panel then double-click on Administrative Tools. 

Double-click on Services, then find the Apache Tomcat 

service. Right-click and select Stop. Wait for the service to 

stop completely. Find the Scala Transmission Server service. 

Right-click and select Stop. Wait for the service to stop 

completely before moving to the next step.  
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Step 3: Restore the data files Restore the data files from 

the backup location to the data files directory. There should 

only be one folder, WEB-INF, in the data directory prior to 

restoring.  

Step 4: Restore the configuration files Restore the 

configuration files from the backup location to the 

configuration files directory. Some files are automatically 

created when Apache Tomcat was started by the installer, 

and must be overwritten when restoring. You must also 

restore the Transmission Server configuration files. When 

restoring these files, existing files must be overwritten.  

Step 5: Restore the database Depending on the type of 

database server you are using, a different set of instructions 

are required in order to restore the Content Manager 5 

database. You should only read and follow the instructions for 

the type of database you are using. 

Step 6: Start Apache Tomcat and Scala Transmission 

Server services  

The restore process is now complete. You can start Apache 

Tomcat and Scala Transmission Server services. 

Go to Start -> Control Panel then double-click on 

Administrative Tools. Double-click on Services, then find the 

Apache Tomcat service. Right-click and select Start. Wait for 

the service to start completely. Find the Scala   Transmission 

Server service.  
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Right-click and select Start. Wait for the service to start 

completely. 

You can now access Content Manager 5. 

8.2.2 PostgreSQL  

 

As with the backup process, pgAdmin is used to restore the 

database. 

If the database schema you’re restoring already exists, you must 

first delete it. Open pgAdmin by navigating to: 

 

Start -> Programs ->PostgresSQL 8.3 -> pgAdmin.  

Connect to your database server using the same Username and 

Password you entered when you installed Content Manager 5.  

Select the database schema you want to delete, then right-click 

and select Delete/Drop. In the “Drop Database?” dialog, click 

Yes. 
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Select Databases, and then click Edit -> New Object -> New 

Database. Type the database schema name you want to restore. 

Make sure the encoding is set to UTF-8. Click OK. 

 



    Content Manager           User Manual  

 

 

268 

 

 

The plpgsql language must be deleted. However, by default it is 

not visible in the user interface.  To show it, navigate to File > 

Options.  Then click the Display tab.  Check the option 

“Languages” and click OK. 

Select the database you just created, and expand it. Then 

expand the Languages entry.  

Select plpgsql then right click and select Delete/Drop. In the 

“Drop Language?” dialog, click Yes. 
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Restore the database tables and data. 

You can now restore the tables and data. Select the database, 

right click, and choose Restore. In the resulting dialog box, 

choose the database backup file that was created. If you backed 

up the database using specific options, you must change the 

restore options accordingly. Otherwise the defaults are okay. 
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Wait for the restore process to finish, and verify that the final 

message is Process returned exit code 0. If a different exit code 

is shown, it indicates that some part of the restore process has 

failed. 
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Using command line You may choose to use the command line 

tool pg_restore.exe to restore the database. To restore a backup, 

execute the following command: 

pg_restore --dbname=cm_01 --format=custom -U postgres -W 

C:\tmp\db.backup 

Please refer to the PostgreSQL manual for more details on the 

command line tools.  

8.2.3 MySQL 

 

If you are using the MySQL database, you must follow these 

steps to restore your backup. Like the backup process, restoring 

the database also uses MySQL Administrator.  
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If the schema you are restoring already exists, it must be dropped 

first. 

 

Open the backup file you want to restore from by choosing 

Restore from the left menu, and clicking the Open Backup File 

button.  

Select the target schema or use the original schema, and check 

Create database(s) if they don’t exist. 
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The backup file must be analyzed before its contents can be 

restored. Click the Restore Content tab, then Analyze Backup 

File Content button to perform this operation. Verify that the 

backup file was successfully analyzed. All tables should be 

selected for restore. 
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Click the Start Restore button to begin. When finished, verify that 

the restore completed successfully. 

 

Using command line  



    Content Manager           User Manual  

 

 

275 

 

You may choose to use the command line tool mysql.exe to 

restore the database. To restore a backup, execute the following 

command: 

mysql -u root -p cm < C:\tmp\backup\cm_backup.sql 

Please refer to the MySQL manual for more details on the 

command line tools.  

8.2.4 Microsoft SQL Server 2000  

 

Using Microsoft SQL Server Enterprise Manager, select the If you 

are using the Microsoft SQL Server 2000 database, you must 

follow these steps to restore your backup. Like the backup 

process, restoring the database also uses Microsoft SQL Server 

Enterprise Manager.  

Select the database you want to restore, and click Tools -> 

Restore Database. 
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Select or type the name of the database you want to restore, then 

select the source to restore from. 
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Click the Options tab. Scala recommends that the default options 

remain unchanged. Once chosen, click OK. 
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If the restore process is successful, you will see this dialog: 

 

Click OK to complete the restore of the database. 

8.2.5 Microsoft SQL Server 2005  

 

If you are using the Microsoft SQL Server 2005 database, you 

must follow these steps to restore your backup. Like the backup 

process, restoring the database also uses Microsoft SQL Server 

Management Studio.  
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Using Microsoft SQL Server Management Studio, delete the 

existing database you want to restore to. DO NOT delete the 

backup and restore history information for the database. 

 

Now start the restore process by right clicking the Databases 

element. 
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Type the name of the database you want to restore. Select the 

From device radio button and click the “...” button. 
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Add the backup file you want to restore from to the list of backup 

locations, and click OK. 
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Make sure to select the Restore checkbox after adding the file: 

 

Check options and execute restore.  Scala recommends that the 

default options remain unchanged. 

Click the OK button to start the restore process. Once complete, 

verify that the restore was successful. 
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Click OK to continue 

 

Click OK to complete the restore of the database. 

8.3 Reporting 

 

The user can generate Playback Audit reports using Content 

Manager. There are three types of reports that the system 

supports; Media Item reports, Player reports and audit reports. 
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In order to for the Content Manager system to generate reports, 

there are a number of steps that must be initiated. 

8.3.1 DB Configuration and Parser Installation 

 

The Playback Audit Parser is an added feature and must be 

installed seperately from Content Manager. 

 

 

The user can configure the Database type and connectivity 

parameters for the parser database. This configuration is per 

network.  The system will default to the correct Schema for the 

network. 
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Before installing the Audit Parser, you must enable Web Services 

in Content Manager.  Once Web Services is enabled, start the 

installer by double-clicking on it, then select Next. 

 on
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This will open the installer. Click Next to continue. 

 

 

Select the radio button for I accept the agreement and click Next 

to continue. 
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The installer will select the appropriate location for the 

installation.  You can change the location using the browse 

button, or select Next to continue. 

Add the appropriate URL for the connection location.  Provide the 

Content Manager User Name and Password. 

 

Select Next to continue. 

Provide the appropriate web services username and password. 
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Select Next to continue. 

 

Any additional tasks that need to be completed will be listed in 

the next dialog box. 

 

Select Next to continue. 

The Microsoft Internet Connection Firewall must allow network 

connections to this application. 
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Select Next to continue. 

You are now ready to install the Audit Playback Parser. 

 

Click Install to continue. 

 

The installer dialog box will provide information about the 

progress of the install. 
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When the installer has completed the install, click Finish.  The 

Playback Audit Parser is now installed on your Scala Content 

Manager system. 

8.3.2 Accessing Reports 

 

Media item summary and detail reports can be generated from 

the Media tab by selecting one or more media items and clicking 

the Report button or by using the Reporting tab on the left hand 

navigation bar. 

 

The “Create Report by Media Items” dialog is shown: 
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You can name the report, specify a date range and choose the 

report type. 

Playback Audit Reports can also be created from the Player list.  

Select one or more players and click the Report button. 

 

When generating Playback Audit Reports from the players list, 

the user can choose a name for the report, specify a date range, 

and choose the report type. The report generated contains the 

relevant information.  

8.3.3 Reports List  

 

The page lists all the reports that have been by generated by a 

user.  
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By clicking on the PDF link, the report will automatically open in a 

PDF viewer (if available).   

 

 

 

Right click on the link and choose “Save Link As…” to save a 

copy of the PDF locally. 

Reports can be deleted by selecting a report and clicking the 

delete button. 

Reports are accessible also from Network > Players under 

Report. 



    Content Manager           User Manual  

 

 

293 

 

 

 

Or from Media > Report. 

Either Player or Media reports can be created by type using the 

dropdown Report Type.  Select either Summary or Detail for the 

correct type of report. 

8.3.4 Report Format 

 

Content Manager allows you to view reports in HTML and PDF 

format. 

8.3.5 Sample Reports 

The system supports two types of reports:  Player reports and 

Media reports. 



    Content Manager           User Manual  

 

 

294 

 

 

Reports can be accessed in the Playback Audit menu by clicking 

Reports.  All available reports will be listed in the primary pane. 

You can add a customizable logo, header, and footer to your 

Playback Audit reports.  

 

 

Additionally, the right-mouse context menu for Media, Messages, 

and Players, now contains a Report selection.  
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Under the Reports tab, you can make a new report, or make a 

New From Existing report.  

 

In these reports, you can select any set of Players, and any set of 

Media Items, by criteria or direct manual selection. If using 

criteria, the matching Players or Media Items will automatically be 

highlighted.  
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Reports are now customized and available in .pdf and HTML 

formats. 
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8.4  Web Services  

8.4.1  Introduction  

 

Web Services is a standards-based approach for other 

applications to communicate with and control Scala Content 

Manager over the network.  

Web Services will let you integrate Content Manager with other 

applications or into other workflows, and extend the functionality 

in certain ways. 

 

Web Services represents an opportunity for partners to add value 

and to successfully address specific verticals. 

8.4.2  Standards 

 

The standards that web services uses are:  
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 SOAP - messages over HTTP or HTTPS. This means it’s 

a standard way to control or query a web-server based 

application over the internet.  

  

(http://en.wikipedia.org/wiki/SOAP)  

 WSDL is a way for a web-server to declare the details of 

the web services that it offers. Content Manager exposes 

the WSDL for its Web Services.  

 

(http://en.wikipedia.org/wiki/Web_Services_Description_L

anguage)  

SOAP and WSDL are well-supported. Visual Studio and 

other development tools can be pointed at the WSDL on 

the Content Manager Server, and they automatically 

generate the necessary interface classes. 

8.4.3  Developer Community  

 

We have created a community for developers to get access to 

important information such as Web Services documentation. 

The Technical Community Wiki will contain important information 

and best practices for large scale networks. 

Share your knowledge on the Wiki.  Visit: 

 

 http://developer.scala.com 

8.4.4  Ideas 

http://en.wikipedia.org/wiki/SOAP
http://en.wikipedia.org/wiki/Web_Services_Description_Language
http://en.wikipedia.org/wiki/Web_Services_Description_Language
http://developer.scala.com/
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Here are some specific ideas you can do using web 

services: 

 

 Build templated Messages from a data source  

Take any data source (RSS, XML, CSV, 

proprietary), and build a set of Messages using 

Templates, and populate a Playlist. 

 Present a playlist over RSS  

Scan the items in a playlist or in a channel, and 

generate an RSS feed containing images and 

details. 

Lets someone view a Content Manager Playlist in 

any RSS reader  

 Convert a Podcast to a Playlist  

Scan a podcast, and upload H.264 video from it 

into Content Manager, and build a Playlist from 

that. 

 Site Configuration Portal  

If you had a network of doctors offices, create a 

simple web portal that lets you enter the name of 

the doctor or practice, and set it as Player 

Metadata using Web Services. 

 Bulk Configuration for large networks 
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Automatically apply a bunch of settings to many Players, perhaps 

from an existing site-database. Or apply settings to many Media 

Items. 

8.5   Scalability  

8.5.1  Before You Start  

 

It is important to plan ahead before configuring and deploying 

your network.  A successful deployment of a network at any size 

starts at the beginning.  Take into consideration the initial network 

size and what it might be in the future. 

It is important to take into consideration the size of the content 

and the number of players.  Make sure to do the bandwidth 

calculations to ensure your network can handle the increase 

traffic load.  

When deploying larger networks, automation is crucial. 

8.5.2  Configuration and Setup Tips 

  

1. Before installing Content Manager, choose hardware 

that matches your network size.  

2. Configure Content Manager to use one port for player 

traffic.  Use a different port for user traffic. 

Tune these parameters to match your needs:  
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 Heartbeat rate  

 Player plan polling interval  

 Plan status interval  

 Synchronization settings  

 Turn off playback logs if you don’t need them  

 

3. Run your database on a dedicated box.  Choose your 

hardware carefully.  

 

4. For reliability and performance you should consider 

setting up your database in HA (High Availability) 

configuration or Master-Master replication.  

 

5. If using a MySQL database, there are lots of tips and 

trick available on the internet.  Google: 

 

 MySQL master master  

 MySQL HA  

 MySQL scalability  

 

6. Do regular backup and maintenance of your database.  

This is extremely important. 
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7. Add a cache server to your network to take the load 

off Content Manager. 

 

A cache will greatly improve your scalability.  Choose 

a caching strategy that fits you: 

 

 Central Cache  

 Regional Caches  

 Local Caches  

Use a dedicated server for caching. Linux is 

preferred.  

Squid-Cache is tested and known to work:  

http://www.squid-cache.org/  

Relevant search keywords:  

 Reverse proxy 

 Web accelerator  

8.5.3  Large Network Deployment  

Deploying a large network (100+ players) can be difficult, labor-

intensive work.  Each player should have local content.  

Individually created playlists for each player will not work, but you 

still want local content on your players.  

http://www.squid-cache.org/
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The answer is player metadata and playlist conditions. Entering 

metadata for each player, even if you only have to do it once, can 

be too much work.  

Player metadata can change over time so you need to do regular 

maintenance. What is the solution?  

 Integrate and automate  

 Content Manager makes it possible for you to integrate 

directly using Web Services.  

 You can link Content Manager to existing CRM systems 

that store metadata.  

 It lets you automatically create and maintain correct 

metadata on all your players with little or no manual labor.  

 Web Services also lets you create and update playlists 

automatically.  

 Makes local content on each player easy at any network 

size.  

8.6 Microsoft SQL Server 2005 

Recommendations 

 

When using a Content Manager with a Microsoft SQL Server 

2005 database, below are routine maintenance suggestions. 

8.6.1 Backups 

 

At a minimum, daily full backups should be scheduled.  A full 

backup captures the state of the database at that moment in 

time.  For example, if a daily backup is performed at 12:00AM 
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and the database fails at 11:00AM, when the database is 

restored, it will be in state it was as of 12:00AM.  The result is a 

loss of 11 hours worth of data. This scenario will all require the 

client to truncate the transaction log manually.  For some clients 

this may be acceptable.  The only requirement for a full backup is 

for the database to be in Simple Recovery model, which is the 

default for all databases when they are created.  

The recommended backup scenario is to perform daily full 

backups and a transactional backup every 15 minutes. In the 

previous example, if a full backup were performed at 12:00AM 

and then a transaction log every 15 minutes between full 

backups, when the database fails at 11:00AM, it can be restored 

up to 10:45AM.  This results in a loss of only 15 minutes worth of 

data. Additionally, with every transaction log backup, the 

transaction log is truncated. This prevents the transaction log 

from running out of disk space and stopping database 

operations.  

In order to perform transaction log backups, the database must 

be placed in Full Recovery model.  In order to implement full 

recovery mode, right-click on the database in SQL Server 

Management Studio and choose Properties, then choose Options 

from the Database Properties window and choose Full from the 

Recovery Model drop-down box.  

To schedule backups, use the Maintenance Plans tool found 

under the Management folder in the SQL Server Management 

Studio. A maintenance plan should be configured for each 

backup type.  Additionally, a file clean up task should be included 

in each plan to prevent old back up files from filling up vital disk 

space.  
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A screen shot of an example plan: 

 

8.6.2 Database Consistency 

 

The Database Consistency Checker “CHECKDB” command 

“checks the allocation, structural, and logical integrity of all the 

objects in the specified database.”  It performs this function by 

running a series of other commands including: CHECKALLOC, 

CHECKTABLE, and CHECKTABLE.  The commands are used to 

detect and repair physical corruptions to the database. 

It is recommended that the CHECKDB command be run monthly 

on production databases and just before a full backup operation.  

The CHECKDB will have to be performed during off peak hours 

on the database, due to the high intensity of the process.  
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Additionally, the database will have to be placed in single-user 

mode in order to use the REPAIR_REBUILD option.  

The CHECKDB command can be implemented in two ways: 

 From a query window in SQL Server Management Studio. 

 Using a SQL Server maintenance plan. 

When using a maintenance plan, choose the Check Database 

Integrity task.  By using the maintenance plan, this important 

check can be scheduled on a regular basis. However, it is 

important to note the REPAIR_REBUILD option is not included 

with the T-SQL created by the maintenance plan. This will have 

to be added.  Additional SQL code will also have to be included 

to place the database in single user mode. 

8.6.3 Index Maintenance 

 

There are two types of indexes used by the Scala databases:  

clustered and non-clustered.  Clustered indexes sort the table 

from A to Z or lowest to highest, just like a phone book.  A non-

clustered index acts much like the index in the back of a book.  It 

tells the query optimizer where to find the data on the hard drive.  

Both aid in the performance of SELECT queries. 

The two techniques for maintaining databases: 

 Re-organizing the index will defrag the leaf level of both 

the clustered and not clustered indexes for all tables and 

views in the database.  It also compacts the index pages 

based on the fill ratio of the index. 
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While a re-organization can be performed while the index 

is online, once the fragmentation of the index has reached 

a greater than 40 percent threshold, it is no longer useful 

and a rebuild is required. 

 Rebuilding an index drops and re-creates the index.  This 

also removes fragmentation, reclaims disk space by 

compacting the pages based on the specified or existing 

fill factor setting, and reorders the index rows in 

contiguous pages. 

 To check the fragmentation level of the data, several 

methods can be employed.  Namely: 

 Check the Fragmentation screen under Index properties 

in SQL Server Management Studio. 

 Go to the Summary tab for the database, then choose the 

Disk Usage report from the Report drop-down menu. 

 

Once the report finishes running, expand the Physical 

Statistics for All Indexes header.  This will list all the 

tables in the database.  Choose the table of interest and 

expand it to reveal all the indexes for that table and the 

recommended actions for the index. 
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The frequency of index maintenance will vary from client 

database to another.  Fragmentation is the result of INSERT and 

DELETE commands on tables which have indexes.  The greater 

number of these commands, the quicker the index will become 

fragmented.  It is recommended to begin with reorganizing all 

indexes on a weekly basis.  As fragmentation increases, change 

the reorganization to a rebuild.  Continue escalating the 

frequency of rebuilds and reorganizations until queries are 

performing optimally. 

Index reorganization can be implemented in two ways: 

 Use the ALTER INDEX command with the REORGANIZE 

option. 

 Use the Reorganize Index task in the maintenance plans. 
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An index rebuild also be implemented in two very similar 

ways to the reorganization: 

 Use the ALTER INDEX command and the REBUILD 

option 

 Use the Rebuild Index task from the maintenance plan. 

8.6.4 Summary 

 

While the items listed in the prior sections are a requirement for 

the health and preservation of a database, the rules for 

implementing the items are not.   

For example, the maintenance of indexes not only varies from 

database to database, but from table to table.  And while one 

client may find it acceptable to only perform transaction log 

backups on the hour, another may find it necessary to execute 

them every minute. 

It is important to review the business rules of the organization 

and determine the best strategy for maintaining the database 

based upon those rules. 

8.7 Script Toolkits 

 

Your Scala Certified Partner can provide custom integration for 

News, Weather and RSS feeds, Coupon Printers, Bar code 

scanners, RFID readers, Hotel Reservation Systems, Casino 

gaming systems, Conference Room scheduling systems, remote 

screen control, interactive way finders, and many other 

applications. 
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Contact your Scala certified partner for a quote on adding this 

functionality to your network. 

  



    Content Manager           User Manual  

 

 

311 

 

  



    Content Manager           User Manual  

 

 

312 

 

||||| 9   | Scala -

End User 

License 

Agreement  
  



    Content Manager           User Manual  

 

 

313 

 

This Software License Agreement (“Agreement”) is entered into between Scala, Inc. (which, for purposes of this Agreement, sha ll be deemed to 

include any wholly owned subsidiary of Scala, Inc.) (“Scala”), and the purchaser, licensee or user (“Licensee”) of Scala Software (as defined 

below). The terms of this Agreement also apply to any Scala Software Updates, and/or Software Maintenance (as each term is de fined below) 

for the Scala software, unless other terms accompany those items. If so, those terms apply. 

READ THIS LICENSE CAREFULLY. BY OPENING THE SCALA SOFTWARE PRODUCT PACKAGING AND/OR USING THE SCALA 

SOFTWARE, LICENSEE AGREES TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT. 

If Licensee does not agree to the terms of this Agreement prior to opening the Scala Software packaging or installing the Sca la Software, 

Licensee shall cease using (or refrain from commencing use of) the Scala Software, and shall, as applicable, uninstall and/or permanently 

delete the Scala Software, Documentation (and any copies thereof) from the computers or computer system(s) on which the Scala  Software has 

been loaded or stored, and return the Scala Software and Documentation, all media on which it is stored, all product packaging, and proof of 

payment to the Scala Partner (as defined below) pursuant to such Scala Partner’s return policy. If Licensee does not agree to  the terms of this 

Agreement, and has acquired the Scala Software as part of a preconfigured computer system on which the Scala Software has been installed, 

Licensee must either promptly cease using the Scala Software, uninstall and/or permanently delete the Scala Software and Documentation (and 

any copies thereof) from the computer system(s) on which the Scala Software has been preloaded, or return the pre-configured system 

pursuant to the system vendor’s return policy. 

1. DEFINITIONS. 

1.1. “Commencement Date” means the ship date of the Scala Software from Scala or a Scala Partner to the Licensee. 

1.2. “Documentation” means the user guides, tutorials, printed instructions, reference manuals, and other explanatory materials developed by 

Scala that accompany or are stored on or in the Scala Software for use in connection with the Scala Software. 

1.3. “End User” means, as applicable, Licensee or any person or entity (including, for the avoidance of doubt, any employee o r agent of 

Licensee) that uses the Scala Software. 

1.4. “Object Code” means the form of Scala Software wherein computer programs are assembled or compiled in magnetic or electronic binary 

form on software media, which are readable and usable by machines, but not generally readable by humans without reverse-assembly, reverse-

compiling, or reverse-engineering. 

1.5. “Software Maintenance” means the provision of Software Updates. 

1.6. “Scala Partner” means any Scala Certified Partner, reseller or distributor of Scala that sold or licensed the Scala Software to Licensee. 

1.7. “Scala Software” means, as applicable, the Object Code form of Scala Starter Kit, Scala Designer, Scala Player, Scala Content Manager, 

Scala Broadcast Server, Scala Ad Manager or such other Scala software products or access licenses as may be identified in a purchase order 

provided to Scala or a Scala Partner, and shall be deemed to include the Documentation for such Scala Software, the license keys, clip ar t, 

fonts and multimedia files included in such Scala Software, their related software options, software extensions, software upgrades and Software 

Updates, and Third Party Software integrated into such identified products. 

1.8. “Software Updates” means bug fixes, documentation improvements and feature additions, including all major (i.e., numbered) and minor 

(i.e., point) releases, when and if made available by Scala. 

1.9. “Third Party Software” means software, referred to as redistributable code that is licensed to Scala by third party licensors for redistribution 

with the Scala Software. The redistributable code is the property of Scala’s licensors, and protected under United States and international 

copyright, trade secret or other proprietary rights laws, and international treaties.  

2. GRANT OF LICENSE RIGHTS. 

2.1 License. Subject to the terms, restrictions and limitations set forth herein, Scala hereby grants to Licensee a non-exclusive, non-

transferable, non-sublicensable license to use (and to permit its End Users to use) the Object Code version of the Scala Software, including any 

Third Party Software included therein or therewith, along with any graphical, textual, pictorial, audio or visual works or materials incorporated 

into or delivered with the Scala Software, including the Documentation. 

2.2 Term. This Agreement is effective as of the date at which Licensee accepts the license terms as set forth above, and will continue unless 

terminated as provided in Sections 7.3 or 8. 

2.3. Scope of License and Use 
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A. Internal Use. Licensee may use the Scala Software and Documentation only for its own internal use and only on one, single-user computer. 

Licensee may internally transfer the Scala Software to a different, single-user computer (a “Transferred Installation”), provided that the Scala 

Software and any copies thereof are permanently uninstalled and/or deleted from the computer from which the Scala Software is transferred. 

B. Limitations. In connection with the development of content files using the Scala Software, Licensee may publish files for use or viewing v ia 

web page or other file protocol. Licensee expressly acknowledges and agrees that a separate, paid Scala Player end user license is required to 

display, perform or otherwise deliver content files created using Scala Software. Licensee shall not, directly or indirectly,  distribute or cause to 

be distributed Scala Software content files in a manner calculated to circumvent the license limitation set forth in this Section 2.3(B). 

C. Copies. Licensee may make one (1) copy of the Scala Software and one (1) copy of the related Documentation for archival or back-up 

purposes, only. 

D. Third Party Software. The license granted hereunder includes the right of Licensee to use the Third Party Software in Object Code form, 

solely in connection with the authorized operation and use of the Scala Software in conformance with the terms and conditions of this 

Agreement. For the avoidance of doubt, Licensee may not decouple, disassemble or otherwise separate the Third Party Software from the 

Scala Software or use the Third Party Software except in connection with the use and operation of the Scala Software as permitted hereunder. 

E. Restrictions. The Scala Software is licensed, not sold. This Agreement only gives you some rights to use the Scala Software. Scala reserves  

all other rights. Unless and solely to the extent otherwise permitted under applicable law, you may use the Scala Software only as expressly 

permitted in this Agreement. Except as expressly permitted under applicable law, or as otherwise agreed to in writing by Scala, Licensee shall 

not, and shall not permit any End User to: (i) work around any technical limitations in the Scala Software; (ii) publish the Scala Software for 

others to copy; (iii) make more copies of the Scala Software than authorized under this Agreement ; (iv) sell, lease, rent, redistribute, assign, 

sublicense, or transfer the Scala Software and/or Third Party Software; (v) reproduce, decompile, reverse engineer or disassemble the Scala 

Software and/or Third Party Software; (vi) offer the use of the Scala Software to third parties as an application service provider, service bureau 

or remote-hosted service; or (vii) deliver, export, transfer or otherwise distribute the Scala Software acquired hereunder to, or use the Scala 

Software acquired hereunder in, a country other than the country in which the Scala Software was purchased (including, for the avoidance of 

doubt, in connection with a Transferred Installation).  

3. LICENSE AND OTHER FEES. Licensee agrees to be bound by and pay the license fee(s) set forth in the Scala Software price list in effect as 

of the date of purchase. License fees for Scala Software and maintenance fees for Software Maintenance may be updated and changed at any 

time. 

3.1 Software Maintenance Coverage. Where Software Maintenance is offered upon separate purchase terms from the Scala Software, the 

Scala Software products are sold with one (1) year (the “Initial Maintenance Term”) of Software Maintenance coverage included in the price of 

the product. During the Initial Maintenance Term, Licensee shall be entitled to Software Updates if and when made available by Scala. All use of 

Scala Software provided pursuant to Software Maintenance coverage shall be subject to the terms of this Agreement. Licensee may elect to 

continue Software Maintenance beyond the Initial Maintenance Term, subject to availability, upon payment to Scala (or, as applicable, a Scala 

Partner) of the Scala annual maintenance fee in effect at the time of renewal. 

3.2 Taxes and Duties. Prices to Licensee do not include taxes, duties, tariffs, handling fees, or other such assessments of any nature. 

Whenever imposed, such assessments are payable by Licensee. Income or other taxes that are required to be paid or withheld by  Licensee or 

Scala under the laws of jurisdictions other than the United States, in connection with the license and other fees paid by Licensee hereunder, are 

the sole obligation of Licensee and shall be exclusive of the license and other fees paid by Licensee. 

3.3 Other Services. Licensee acknowledges that any additional services offered by Scala, such as installation, customization or professional 

services, are not provided under this Agreement, and any such services to be provided by Scala (or, as applicable, a Scala Partner) shall be 

subject to the mutual agreement of the parties, the terms and conditions for which shall be set forth in a separate agreement. 

4. CONFIDENTIAL INFORMATION, TITLE AND COPYRIGHTS. 

4.1 Licensee acknowledges that the Scala Software, Documentation, Software Updates, enhancements, modifications, additions, new releases 

of or to the Scala Software contain confidential information of, are trade secrets of, and are proprietary to Scala and its licensors and that title to 

such materials is and shall remain in Scala and its licensors, as the case may be. Licensee shall maintain in strict confidence the Scala 

confidential information, but, at a minimum, to take those precautions that it utilizes\ to protect its own confidential information. Licensee shall 

have no obligation of confidentiality with respect to information that (i) at the time of disclosure is in or becomes available to the public through 

no breach of this Agreement on the part of the Licensee; (ii) was lawfully in Licensee’s possession prior to receipt from Sca la; (iii) is received 

independently from a third party free to lawfully disclose such confidential information to Licensee and who does not owe an obligation to Scala 

with respect to confidential information; (iv) Licensee independently develops without the benefit of any confidential information disclosed 

hereunder or (v) is required to be disclosed by a government agency; provided that the Licensee will use best efforts to minimize such 

disclosure and will notify Scala promptly of any such demand, order or judgment in order to permit Scala to seek an appropria te protective order. 
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4.2 All applicable rights to patents, copyrights, trademarks and trade secrets in the Scala Software and other proprietary materials are and shall 

remain in Scala and its licensors. Licensee shall not assert any right, title or interest in the Scala Software or other materials provided to 

Licensee under this Agreement, except for the limited license rights expressly granted to Licensee hereunder.  

4.3 Licensee shall not obscure or remove any copyright or other proprietary notice or legend contained on or included in the Scala Software and 

shall reproduce all such information on all copies made hereunder. Licensee shall not, directly or indirectly, disclose or distribute any technical 

information of Scala provided with or in the Scala Software without the prior written consent of Scala, which consent may be withheld at Scala’s 

sole discretion. 

5. LIMITED WARRANTIES. 

5.1 Media and Documentation. Scala warrants that if the media or Documentation is in a damaged or physically defective condition at the time 

the Scala Software is delivered to Licensee, and if such media or Documentation is returned to Scala within thirty (30) days of the effective date 

of this Agreement, Scala will provide Licensee with a replacement at no charge. 

5.2 Software Limited Warranty and Remedy. 

A. Provided that Licensee is not in breach of any of its obligations under this Agreement, and in addition to the warranty set forth in Section 5.1, 

Scala warrants for a period of thirty (30) days from the Commencement Date (“Warranty Period”), that the software will substantially conform to 

the 

Documentation provided by Scala with the Scala Software. Licensee’s sole remedy and Scala’s and Scala Partner’s sole obligation under this 

Agreement for breach of this warranty is, at Scala’s sole option, (i) the remedy of the nonconformity or (ii) the authorization of a refund for the 

price paid for the media and or Scala Software by Scala or the Scala Partner from which the Scala Software was originally obtained. Any 

request for the above remedies must be made within the Warranty 

Period and proof of purchase (i.e., copy of the invoice or receipt) is required to be presented to Scala. In the event  of a refund, this Agreement 

will immediately terminate without further notice, and Licensee will have no further rights or license to use Scala Software or Documentation.  

B. Any replacement software or media will be warranted for the remainder of the original Warranty Period or for an additional thirty (30) days 

whichever is longer. 

C. This limited warranty is void if nonconformance of the Scala Software results from or is related to the (i) improper insta llation or operation of 

the Scala Software by or on behalf of the Licensee, (ii) failure of Licensee’s hardware or non-Scala software, (iii) incompatibility of such 

hardware and non-Scala software systems with Scala Software, (iv) alteration, modification or unauthorized integration of Scala Software by or  

on behalf of Licensee, or (v) accident, abuse or misapplication of Scala Software. 

D. If the Scala Software is provided as a trial or evaluation version, the grant of the license to use the Software shall be on an “AS IS” basis and 

subject to the express limitations of the trial. Unless Licensee shall have entered into a separate written license agreement prior to the expiration 

or termination of the trial period, Licensee agrees to cease all use of the Scala Software provided on a trial or evaluation basis and to return 

such Scala Software, or to return any license keys and destroy or permanently delete any and all copies of such Scala Software. 

5.3 Disclaimer of Warranties. SCALA AND ITS LICENSORS MAKE NO WARRANTY, REPRESENTATION OR PROMISE EXCEPT AS 

SPECIFICALLY SET FORTH IN THIS AGREEMENT. TO THE FULLEST EXTENT PERMITTED BY LAW, SCALA AND ITS LICENSORS 

DISCLAIM AND EXCLUDE ANY AND ALL OTHER WARRANTIES, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR RESULTS. SCALA AND ITS LICENSORS DO NOT WARRANT THAT 

THE SCALA SOFTWARE OR DOCUMENTATION WILL SATISFY LICENSEE’S REQUIREMENTS; THAT THE SCALA SOFTWARE AND 

DOCUMENTATION ARE WITHOUT DEFECT OR ERROR; OR THAT THE OPERATION OF THE SCALA SOFTWARE WILL BE 

UNINTERRUPTED. TO THE MAXIMUM EXTENT PERMITTED UNDER THE LAW, THE UN CONVENTION FOR THE SALE OF GOODS AND 

THE UNIFORM COMMERCIAL CODE DO NOT APPLY TO THIS LICENSE AGREEMENT. 

6. LIMITATION OF LIABILITY. 

6.1 IN NO EVENT SHALL SCALA OR ITS LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE OR 

CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, 

BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS). REGARDLESS OF WHETHER 

SCALA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY LAW, SCALA’S 

AGGREGATE LIABILITY ARISING FROM OR RELATING TO THIS LICENSE 



    Content Manager           User Manual  

 

 

316 

 

OR THE SCALA SOFTWARE AND DOCUMENTATION IS LIMITED TO THE AMOUNT ACTUALLY PAID FOR THE LICENSE. SOME 

JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE 

ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY. 

7. INDEMNIFICATION. 

7.1 Scala’s Obligation. Subject to the Licensee indemnification set forth at Section 7.2 and the restrictions and limitations set forth herein, 

Scala shall indemnify and hold harmless Licensee, its officers, directors and employees from and against any costs or demands  awarded 

against Licensee by a court of competent jurisdiction pursuant to a final judgment as a result of a claim or action by a third party against 

Licensee that the Scala Software or Documentation infringes a registered copyright, trademark, valid patent or other intellec tual property right of 

a third party in North America, European Economic Area or Japan. The foregoing indemnity is conditioned on Licensee (i) promptly notifying 

Scala of such claim; (ii) permitting Scala to control the response thereto and the defense thereof, including any agreement relating to the 

settlement thereof, and (iii) assisting and cooperating with Scala, at Scala’s expense, in the defense or settlement thereof. Licensee may 

participate, at its own expense, in such defense directly or through counsel of its choice on a monitoring, non-controlling basis. Scala shall 

obtain Licensee’s prior written consent to any compromise or settlement of any claim which would require an admission of liability on the part of 

Licensee or which would subject Licensee to any injunction or other equitable relief. Notwithstanding the foregoing, in no event shall Scala or its 

licensors be liable to indemnify, defend, settle or hold Licensee harmless from and against any or all claims which allege infringement of 

intellectual property that reads upon or is infringed by a generally recognized audio, video, technology or patent standard, including without 

limitation MPEG-1, MPEG-2, MPEG-4, JPEG, DV, Flash, VC-1, AAC, AC-3, DVCPRO or AVS (each including all profiles, options, parts or 

levels); 

7.2 Scala shall have no obligation under Section 7.1, and otherwise will have no liability for, any claim of infringement caused or alleged to be 

caused by: (i) the use or combination of the Scala Software with non-Scala software, hardware, data, or content, including but not limited to 

software, hardware, data, or content of Licensee; (ii) infringement that would have been avoided without the use or combination of the Scala 

Software with other non-Scala software, hardware, content, or data; (iii) the presence of any alteration or modification of the Scala Software by 

Licensee or any third party acting on Licensee’s behalf; or (iv) the Licensee’s continuing the allegedly infringing activity after being notified 

thereof or after being informed and provided with modifications that would have avoided the alleged infringement. 

7.3 In the event that a claim of infringement of a valid North American, European Economic Area or Japanese software patent or copyright is 

made against Scala or Licensee or if Scala reasonably believes that such a claim will be made, Scala, at its option and in lieu of indemnification, 

may (a) procure for Licensee the right to use the Scala Software without patent or copyright infringement; (b) modify the Sca la Software to make 

it noninfringing; (c) replace the Scala Software with substantially equivalent software that is non-infringing; or (d) direct Licensee to cease use of 

the Scala Software, and refund to Licensee a percentage of the aggregate fees received for such Scala Software that are the subject of such a 

claim, based on a five (5) year straight line depreciation 

7.4 The foregoing Sections 7.1-7.3 set forth the exclusive remedy and entire liability and obligation of Scala with respect to third party claims 

against Licensee alleging intellectual property infringement or misappropriation. 

7.5 Licensee Obligation. Except for the infringement claims set forth in Section 7.1, Licensee shall indemnify, defend and hold Scala, its 

directors, officers, agents and employees harmless from any claims, demands, or causes of action whatsoever by a third party against Scala 

arising as a result of Licensee’s use or operation of the Scala Software. For the avoidance of doubt, and without limiting the scope of the 

immediately preceding sentence, Licensee shall indemnify, defend and hold Scala, its directors, officers, agents and employees harmless from 

any third party claims, demands, or causes of action whatsoever arising from or related to the display, broadcast, reproduction, performance or 

other use or distribution of audio, visual, graphical and textual information developed by or on behalf of Licensee and not included in the Scala 

Software. 

8. TERMINATION. 

8.1 By Licensee. Licensee may terminate this Agreement at any time without notice to Scala. The license fee is not re fundable and Scala will 

have no obligation to refund any amounts paid by Licensee under this Agreement upon its termination (except for any right of refund as set forth 

in Sections 5 and 7.3). 

8.2 Scala. Scala may terminate this Agreement and all licenses granted hereunder upon thirty (30) days prior written notice if Licensee fails to 

comply with any of the terms and conditions of this Agreement or any Schedule to this Agreement, and such noncompliance is no t cured within 

such thirty (30) day period. 

8.3 Return of Software. Upon any termination of this Agreement, Licensee must cease all use of the Scala Software, and return to Scala all 

copies of the Scala Software, including license keys, together with the Documentation, or shall return all license keys and certify to Scala’s 

reasonable satisfaction the destruction or permanent deletion of all copies of the Scala Software and Documentation from its computer systems. 

9. GENERAL. 
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9.1 Audit Rights. Scala shall have the right reasonably to audit the deployment and use of the Scala Software by Licensee, including without 

limitation Licensee’s conformance with the provisions of Section 3 herein. Licensee agrees to cooperate with Scala’s reasonab le request for 

access to Licensee’s computer systems to ensure Licensee’s adherence with the license terms hereunder.  

9.2 Purchase in Canada. If Licensee acquired this software in Canada, Licensee agrees to the following: The parties hereto have expressly 

required that the present Agreement and any exhibits hereto be drawn up in the English language. / Les parties aux presents ont expressément 

exigé que la présente convention et ses Annexes soient rédigées en langue anglaise. 

9.3 Notices. Any notice required or permitted to be given by Licensee hereunder shall be in writing and shall be deemed to have been duly 

given (i) upon hand delivery, (ii) on the third day following delivery to the postal service as certified mail, return receipt requested and postage 

prepaid, or (iii) on the first day following delivery to a recognized overnight courier service, fee prepaid and return receipt or other confirmation of 

delivery requested. Any such notice shall be delivered or sent to Scala at the address as set forth below, or to such other address as Scala may 

designate from time to time. Scala, Inc., 350 Eagleview Boulevard, Suite 150, Exton, PA 19341, USA. 

NOTICE ABOUT THE MPEG-2 VISUAL STANDARD. This software may include MPEG-2 visual decoding technology. MPEG LA, L.L.C. 

requires this notice: USE OF THIS PRODUCT IN ANY MANNER THAT COMPLIES WITH THE MPEG 2 VISUAL STANDARD IS PROHIBITED, 

EXCEPT FOR USE DIRECTLY RELATED TO (A) DATA OR INFORMATION (i) GENERATED BY AND OBTAINED WITHOUT CHARGE 

FROM A CONSUMER NOT THEREBY ENGAGED IN A BUSINESS ENTERPRISE, AND (ii) FOR PERSONAL USE ONLY; AND (B) OTHER 

USES SPECIFICALLY AND SEPARATELY LICENSED BY MPEG LA, L.L.C. If you have questions about the MPEG-2 visual standard, please 

contact MPEG LA, L.L.C., 250 Steele Street, Suite 300, Denver, Colorado 80206; http://www.mpegla.com. NOTICE ABOUT THE AVC VISUAL 

STANDARD. This software may include AVC visual decoding technology. MPEG LA, L.L.C. requires this notice: THIS PRODUCT IS LICENSED 

UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL AND NONCOMMERCIAL USE OF A CONSUMER TO (i) ENCODE 

VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A 

CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 

LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL 

INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP:// WWW.MPEGLA.COM 

9.4 Governing Law. 

A. United States Sales. If you acquired the Scala Software in the United States, Pennsylvania state law governs the interpretation of this 

agreement and applies to claims for breach of it, regardless of conflict of laws principles. 

B. Sales Outside the United States. If you acquired the Scala Software in any other country outside the United States, the laws of the country 

of the wholly-owned Scala subsidiary that sold the Scala Software to you applies, regardless of such country’s conflicts of law provisions. 

9.5 Legal Effect. This Agreement describes certain legal rights. You may have other rights under the laws of your state or country. You may 

also have rights with respect to the party from whom you acquired the Scala Software. This Agreement does not change your rights under the 

laws of your state or country if the laws of your state or country do not permit it to do so. 

9.6 U.S. Government Restricted Rights Legend. The Scala Software, hardware, and Documentation provided under this Agreement bear 

restricted rights. Use, duplication, or disclosure by the U.S. Government is subject restrictions as set forth in subparagraph (c)(1)(ii) of the rights 

in technical data and computer software clause at DFARS 252.227- 7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 

Software Restricted Rights clause at 48 CFR 52.277-19, as applicable. Scala, Inc., 350 Eagleview Boulevard, Suite 150; Exton, PA 19341 USA. 

9.7 Assignment. Neither party may assign any rights, duties, obligations or privileges under this Agreement without the prior written consent of 

the other party. A change of control or ownership shall not be deemed to be an assignment under this Section so long as the new owner has 

expressly assumed in writing all of the duties and obligations of the assignor and further provided, that Licensee shall remain liable and 

responsible to Scala (and its licensors) for the performance and observance of all such duties and obligations.  

9.8 Severability. Should any part or provision of this Agreement be held unenforceable or in conflict with the law of any jurisdiction, the validity 

of the remaining parts or provisions shall not be affected by such holding.  

9.9 Limitation on Effect of Waiver. Failure on the part of Scala to exercise, or Scala’s delay in exercising, any of Scala’s rights hereunder shall 

not be construed as a waiver or waiver of other breaches of this Agreement. Any single or partial exercise by a party of any right shall not 

preclude any other or future exercise thereof or the exercise of any other right in the Agreement. 

9.10 Entire Agreement. This Agreement contains the entire understanding of the parties with respect to the transactions contemplated and 

supersedes any prior agreements or understandings among the parties with respect to the subject matter hereof. This 

Agreement may be amended only by a writing that refers to this Agreement and is signed by both parties. 

http://www.mpegla.com/
http://www.mpegla.com/
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9.11 Export Law Assurances. Licensee acknowledges that the Scala Software included herewith is subject to restrictions and controls 

imposed under the U.S. Export Administration Act and Canadian Exportation Laws. Licensee must comply with all domestic and international 

export laws and regulations that apply to the software. These laws include restrictions on destinations, end users and end use. Licensee hereby 

expressly agrees to defend, hold harmless and indemnify Scala, its directors, officers, and employees, from any claim, suit o r dispute alleging 

that Licensee has exported the Scala Software in violation of any domestic or international export laws. 

9.12 Construction. The headings in this Agreement are for convenience of the parties only. They do not constitute a portion of this Agreement 

and shall not be used in interpreting the constriction of this Agreement.  

9.13 Third Party Beneficiary. Licensee hereby agrees that the licensors of Third Party Software shall be considered third party beneficiaries of 

this Agreement and shall be entitled to bring a direct action against Licensee in the event of breach of any applicable provisions of this 

Agreement, pursuant to the terms and conditions of this Agreement. 

9.14 Force Majeure. Neither party shall be in default if failure to perform any obligation hereunder is caused solely by unforeseen supervening 

conditions beyond that party’s reasonable control, which could not have been prevented by the non-performing party’s reasonable precautions, 

commercially accepted processes or substitute services, including acts of God, civil disturbances, strikes and labor disputes . 

9.15 Negation of Agency and Similar Relationships. Nothing contained in this Agreement shall be deemed to create an agency, joint venture 

or partnership relationship
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